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Introduction
This guide is intended for healthcare organizations so that they can manage, 
automate, and coordinate customer processes. The procedures detailed in this guide 
are intended to help administrators set up and maintain Siebel eHealthcare.

This guide will be useful primarily to people whose titles or job descriptions match 
one of the following:

Siebel eHealthcare Guide provides detailed descriptions of Siebel eHealthcare. 
Siebel eHealthcare is targeted at healthcare organizations; therefore, industry-
specific terminology is used throughout. Readers should have a general 
understanding of the healthcare industry and its terminology.

Call Center 
Representatives

Persons responsible for customer service.

Call Center 
Administrators

Persons responsible for setting up and maintaining a call center; duties 
include designing and managing Computer Telephony Integration 
(CTI), SmartScripts, and message broadcasts.

Database 
Administrators

Persons who administer the database system, including data loading; 
system monitoring, backup, and recovery; space allocation and sizing; 
and user account management.

Marketing 
Administrators

Persons responsible for setting up and maintaining a marketing 
department; duties include designing and managing campaigns, 
product marketing information, and product distribution lists.

Sales Representatives End users of the Siebel application, who may connect to the network 
through a dedicated or mobile connection.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining Siebel 
applications.

Siebel Application 
Developers

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 

Trainers Persons responsible for training end users of the Siebel eHealthcare 
application.
Version 7.5, Rev. A Siebel eHealthcare Guide 11



Introduction

How This Guide Is Organized
How This Guide Is Organized
This guide covers the features that are specific to Siebel eHealthcare. With the 
exception of the preliminary chapters, each chapter in this guide addresses a set of 
end-user and administrator procedures that are performed using a particular screen 
in Siebel eHealthcare. These chapters are workflow-oriented, guiding you through 
an example sequence of procedures to illustrate the use of Siebel eHealthcare.
12 Siebel eHealthcare Guide Version 7.5, Rev. A



Introduction

Additional Resources
Additional Resources
This guide should be used in combination with other books in the Application 
Administration section of the Siebel Bookshelf. However, the information in this 
guide supersedes information about Siebel products provided in other 
documentation.

In addition, it is strongly recommended that you read Fundamentals so that you can 
make optimal use of your Siebel application, especially if you are new to Siebel 
software. Fundamentals provides detailed coverage of the Siebel user interface and 
how to use it; working with data; locating information with the query and find 
features; sharing information with other users; and so on. The features presented 
in Fundamentals appear throughout the Siebel application suite; they are 
introduced through procedures you can learn and use in your own Siebel 
application.
Version 7.5, Rev. A Siebel eHealthcare Guide 13



Introduction

Revision History
Revision History
Siebel eHealthcare Guide 

Version 7.5, Rev. A
Table 1. Changes Made in Version 7.5, Rev. A

Topic Revision

"Glossary"  The book's Glossary section has been removed. The glossary 
definitions have been added to the main Glossary book. 
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Overview 1
Siebel eHealthcare includes various modules that you can mix and match according 
to your business needs. The next section, “Siebel eHealthcare Functionality” on 
page 16, describes Siebel eHealthcare functionality.

Siebel eHealthcare is built upon the Siebel eBusiness Architecture, including Siebel 
Sales, Siebel Service, and Siebel Call Center applications. Like many other Siebel 
eBusiness Applications, Siebel eHealthcare uses the Siebel Proposal Generator, 
Siebel Data Model, the Siebel Object Architecture, and the Siebel Application Server 
Architecture. 
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Siebel eHealthcare Functionality
Siebel eHealthcare offers a solution for relationship management in the healthcare 
market that includes the health insurance, employee benefits, and care delivery 
sectors. Built on the strengths of Siebel's industry-leading eBusiness applications, 
Siebel eHealthcare allows organizations to successfully manage relationships 
throughout the entire customer lifecycle, across all stakeholder touchpoints. This 
provides a platform for identifying new opportunities and expanding upon existing 
business relationships. Recognizing that success comes from relationships with the 
expanded community of stakeholders, Siebel eHealthcare’s suite of applications 
focus on the expanded healthcare ecosystem: insurance subscribers and members 
as well as employer accounts, independent brokers, direct sales channels and 
providers (health systems, physicians, hospitals, networks, ancillary providers).

By using Siebel's eBusiness applications, Siebel eHealthcare provides solutions to 
address the industry's most pressing business issues.

The Siebel eHealthcare solution sets include:

■ End-to-End Sales

■ Manage Opportunity and Account Tracking for prospecting, renewal, and lost 
business analysis

■ Team based selling (including external team members such as brokers)

■ Sales Manager views to facilitate team management 

■ Embedded Sales strategy tools such as Miller-Heiman Strategic Selling

■ Capture of information for rating and underwriting such as census and health 
risk assessment

■ Automation capabilities to make sure that quotes and installed cases move 
through the organization

■ Agent/Broker/Consultant Solutions

■ Profiling capabilities to track licenses, appointments, errors & omissions 
coverage, agency affiliation

■ Ability to assign an agent or broker to an opportunity or account
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■ Management tools to assess the relative value of various selling partners

■ Delegated administration to allow agencies to administer their own user 
names and passwords

■ Group Account Relationship Management

■ Ability to communicate new product information and tailored messages 
about the plan consistently across every interface

■ Streamline the open and ad hoc enrollment processes. Employees can self-
enroll online or administrators can submit enrollment by using the group 
portal

■ Manage service issues with analytics and reports. Employers can have 
visibility into aggregate claims data, physician networks and other relevant 
plan information

■ Promote online self-service as an avenue for quick resolution of billing issues 

■ Agent Tools

■ Support demand from web, fax, phone and email from a single interface

■ Address common inquiries with a dashboard of eligibility information, 
claims history, service history, and log of customer interactions

■ Use assignment manager and workflow products to allow agents to follow 
best-practice procedures

■ Allow new agents to get up to speed through the use of scripting tools and a 
common solution library

■ Health Management

■ Use the Events module to track available health classes and clinics and enroll 
members and patients

■ Create Activity plans and use workflow tools to outline the appropriate 
activities and resources required to proactively manage care

■ Develop campaigns for managing enrollment of at-risk populations in care      
management programs
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■ Provide information to educate members on critical life events, disease 
specific services, and available health classes

■ Use analytics capabilities to track and monitor the success of classes and 
programs

■ Provider Relationship Management

■ Consolidate critical information from back office systems related to 
individual physicians and other providers. This supports effective responses 
to inquiries and proactive management of the contracting relationship

■ Track key information on individual physicians such as panel size and status, 
location, office hours and hospital admitting privileges

■ Search for providers and facilities in a geographic radius using Geocode 
searching capabilities

■ Access provider information online using a secure website

■ Generate provider reports by specialty, product, or state

■ Offer provider portal to promote self-service for common inquiries
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Getting Started 2
This chapter lists the applications administration tasks that are specific to 
Siebel eHealthcare. Use this chapter in combination with Siebel Applications 
Administration Guide.

Siebel Applications Administration Guide covers the setup tasks that are common 
to all Siebel eBusiness Applications, such as using license keys, defining employees, 
and defining your company’s structure. It also provides the information you will 
need to implement, configure, and monitor the Siebel sales, service, and marketing 
products and to perform data administration and document administration tasks.

This guide assumes that you have already installed or completed the upgrade of 
Siebel eHealthcare. If you have not, go to the Installation/Upgrade section of the 
Siebel Bookshelf and click the links to the guides that are relevant to your company’s 
implementation.

The Siebel database server installation script creates a Siebel administrator account 
that can be used to perform the tasks described in this guide. For more information 
about this process, see the Installation Guide for your operating system.

CAUTION: Do not perform system administration functions on your local database 
using the Mobile Web Client. Although there is nothing to prevent you from doing 
this, it can have serious results, such as data conflicts, an overly large local 
database, or a large number of additional transactions to route.
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Renaming Siebel Account Objects
In general, Siebel applications refer to companies as accounts. In the Financial 
Services industry the term account has typically been synonymous with financial 
accounts so historically the word company has been used in many places in 
Siebel eHealthcare. By default, Siebel eHealthcare installs using the term accounts. 
Users can change this term and use another description, such as Companies, 
Clients, or Customers. Users wishing to change this default need to rename all Siebel 
Account objects prior to deployment. For more information, see the Upgrade Guide 
for your operating system.

NOTE: All of the chapters is this guide are written assuming you have renamed Siebel 
Account objects to Companies.

Configuring Lists of Values
In Siebel eHealthcare, the List of Values (LOV) should be modified in accordance 
with the terminology used by your financial institution. For example, the list of 
transaction types used in Siebel eHealthcare should match those used by your 
financial institution. For more information on configuring a LOV, see Siebel 
Applications Administration Guide.

NOTE: This may impact certain forms and lists, which rely on the preconfigured 
values for correct operation.
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Configuring Summary Views
In Siebel eHealthcare, summary views have been restructured. In the past, multiple 
summary views existed, typically one summary view for a particular type of user. 
For example, there were preconfigured summary views specifically for salespeople 
and customer service agents. This has been replaced by common summary views 
whose appearance can be configured by individual end users.

Users can change the way a list appears in a summary view using the controls in 
the top right corner of each list. These controls, described in Table 2, allow users to 
manage what appears on the summary view. 

Any changes made to a summary view layout are only visible to the current user 
and remain in effect until that user changes them again or reverts to the default 
layout. If users hide a list, they must click Edit Layout to restore it. For more 
information, see “Editing a Summary View Layout” on page 22.

Table 2. Summary View Controls

Button Description

Hide Temporarily hides a list or form from view.

Collapse Collapses the list of records. If the list cannot be collapsed, the expand 
button appears instead of the collapse button.

Expand Expands the list of records. If the list cannot be expanded, the collapse 
button appears instead of the expand button.
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Editing a Summary View Layout
Using the Edit Layout view, users can restore hidden lists, collapse or expand all 
lists, move lists or forms up or down on the page, or revert to the default layout. 
Using the edit layout buttons, described in Table 3, users can change the way a 
summary view appears and apply those changes to future sessions.

For more information on available summary views, see “Viewing a Contact 
Summary” on page 82, “Viewing a Company Summary” on page 63, and “Viewing 
a Household Summary” on page 94.

Table 3. Edit Layout Buttons

Button Description

Collapse Collapses the list or form.

Expand Expands the list or form.

Move up Moves the list or form up on the home page.

Move down Moves the list or form down on the home page.

Show Displays the list or form on the home page.

Hide Hides the list or form from view on the home page.
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Adding Products and Product Lines
Administrators must set up products, such as health insurance products, in 
Siebel eHealthcare. After setting up a product, administrators can specify that it be 
included in a product line. They can also specify which product lines your company 
contracts agencies to sell or which ones the state licenses agencies to sell.

Setting up products is discussed in detail in Product Administration Guide. However, 
this guide also explains some steps for adding products in the appropriate chapters. 
In those chapters, values for specific fields are given to help administrators set up 
products correctly.

NOTE: Only those users with the required administrative responsibilities, such as 
Siebel administrators, can add products and information about product lines. 
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An opportunity is a potential revenue-producing event related to one or more 
companies or individuals. An opportunity often has a close date, a win probability, 
and a sales team. It is typically related to contacts, products, decision issues, 
activities, and competitors. 

In Siebel eHealthcare, opportunities help an organization to nurture and manage 
the entire life cycle of a revenue-generating opportunity, from creation to closing. 
Relationship managers and sales representatives, who are responsible for managing 
and generating revenue, use opportunity information on a regular basis. Top 
management also uses the opportunity analysis tools in Siebel eHealthcare to 
analyze pipeline performance and help manage overall business performance 
through well-planned strategic-selling activities.

Using the procedures given in this chapter, you will be able to perform the 
administrator tasks of adding an opportunity from the Data Administration screen, 
managing the sales team assigned to an opportunity, specifying primary sales team 
members, and configuring persistent filters. 

End users use the Opportunities screens to add an opportunity, create an 
opportunity from an application, and review opportunity details. 

This chapter describes opportunity functionality that is unique to 
Siebel eHealthcare. For more information on basic opportunity functionality, see 
Siebel Call Center User Guide and Siebel Sales User Guide.
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Business Scenario
This scenario features sample tasks performed by sales representatives and their 
managers in the healthcare industry. Your company may follow a different workflow 
according to its business requirements.

Sales Representative Creates New Opportunity
In this scenario, the sales representative has a new lead. The company is already 
entered in Siebel eHealthcare, and the individual the representative is calling on is 
already a contact for that company.

The customer calls to let the sales representative know that she is interested in 
creating a better health insurance plan for her employees. She would like the sales 
representative to present a proposal. If that goes well, she will want to discuss the 
terms of the deal.

First, the sales representative creates a new opportunity record. Then, he schedules 
the meeting, records the associated activities on his to-do list, and enters the terms 
of the proposal.

As the sales process continues, the sales representative continues to gather 
information about the company, its contacts, and the opportunity. At any time, he 
can review a summary of the profile, sales team, contacts, and activities associated 
with this opportunity.

Every morning, the sales representative’s manager reviews the opportunities 
created the previous day. The manager evaluates the new opportunities and 
determines if she should add more members to each opportunity’s sales team to 
make sure it is covered sufficiently. In a few critical cases, she decides to change the 
primary team member from the sales representative to herself.

In this scenario, end users are sales representatives who manage opportunities in 
the field. They use the Opportunities screen to:

■ Create new opportunities for new and existing accounts

■ Update existing opportunities

■ View information about an opportunity
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Opportunities Sample Tasks
Figure 1 illustrates sample tasks that administrators and end users typically perform 
when managing opportunities.

Figure 1. Opportunities Sample Tasks
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Administrator Procedures
The following administrator procedures are described in this section:

■ To add an opportunity from the Data Administration screen

■ To add or delete members of the sales team for an opportunity on page 29

■ To change the primary sales team member for an opportunity on page 29

■ To secure an opportunity on page 30

■ To add a field with a list of values to the Opportunities persistent filter on 
page 31

■ To add a picklist field to the Opportunities persistent filter on page 32

Adding an Opportunity as an Administrator
Administrators can add, modify, and delete opportunities from the Data 
Administration screen, as well as the Opportunities screen.

To add an opportunity from the Data Administration screen

1 From the application-level menu, choose View > Site Map > Data 
Administration > Opportunities.

2 In the Opportunity form, add a record and complete the necessary fields.

NOTE: Deleting an opportunity completely removes the opportunity, as well as every 
activity related to the opportunity, from the system. If you are unsure whether the 
opportunity is still active (and therefore should not be deleted), you can remove 
yourself from the opportunity team instead of deleting the record.
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Managing Opportunities
You may want to modify the members of the sales team for an opportunity or 
change the primary team member designation. When the existing primary is a 
direct report, a manager can change the primary team designate using the 
Opportunity Sales Team view. If you are logged in as an administrator, you can 
change the primary team designate for any opportunity in the Opportunity 
Administration view. 

You can also secure an opportunity in order to restrict visibility in the All 
Opportunities view to just the members of the sales team. When the Secure field is 
checked, the opportunity is hidden from other users. A secured opportunity can 
only be viewed by members of the sales team from the All Opportunities or the My 
Opportunities view.

NOTE: The primary sales team member for an opportunity can also add and delete 
sales team members, and edit the Secure flag setting.

To add or delete members of the sales team for an opportunity

1 From the application-level menu, choose View > Site Map > Data 
Administration > Opportunities.

2 In the Opportunities list, select an opportunity.

3 In the Opportunity form, click the show more button to expand the form.

4 In the Sales Team field, click the select button.

The Sales Team Members dialog box appears.

5 To add an employee to the sales team, click New and select the employee in the 
Add Employees dialog box.

6 To delete an employee from the sales team, select the employee in the Sales 
Team Members list and click Delete.

To change the primary sales team member for an opportunity

1 From the application-level menu, choose View > Site Map > Data 
Administration > Opportunities.
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2 In the Opportunities list, select an opportunity.

3 In the Sales Team field, click the select button.

The Sales Team Members dialog box appears.

4 Clear the current Primary sales team member.

5 Select a new Primary designate by clicking the check box in the Primary field.

To secure an opportunity

1 From the application-level menu, choose View > Site Map > Data 
Administration > Opportunities.

2 In the Opportunities list, select an opportunity that you want to secure (lock).

3 In the Opportunity form, click the Secure check box. 

Only the primary member of the sales team or the Siebel administrator can set 
the Secure check box. When an opportunity is marked Secure, only members of 
the sales team can view it in the All Opportunities view. Sales team members 
can also see a secure opportunity in their My Opportunities views. 

Configuring Persistent Filters
Using Siebel Tools, administrators can modify the appearance of screens and views 
in Siebel eHealthcare. For more information see Siebel Tools Reference. 

Siebel eHealthcare provides persistent filters for the Opportunities, Activities, Event 
Calendar, Sub-Events, and Sessions screens. By default, this filter does not appear 
on the Opportunities screen, but can be configured to appear on the Opportunities 
views. For more information on persistent filters for screens other than 
Opportunities, please see the relevant chapter.
30 Siebel eHealthcare Guide Version 7.5, Rev. A



Opportunities

Administrator Procedures
The purpose of the Persistent Filter is to provide a mechanism that will allow quick 
filtering of records on selected fields without needing to enter query mode in a list. 
It is possible to modify the field selection of these filters using Siebel Tools. 
Administrators can add or remove fields from the existing persistent filters for the 
Opportunities, Activities, and Events screens. 

NOTE: Creating new persistent filters is not recommended.

To add a field with a list of values to the Opportunities persistent filter

1 In Siebel Tools, locate the appropriate applet (for example, FINS Opportunity 
Filter Form Applet). 

2 Lock the project.

3 In the Object Explorer, drill down under the Applet node and select Controls.

4 Add the desired field to the list, with the Name, Caption, Field, and Pick Applet 
fields populated with appropriate values. 

NOTE: You can use an existing control with an LOV in the filter applet, or the 
control on the base list or form, as a source of comparison. 

For example, Lead Quality was added with the following fields and values:

The other fields were left at default values.

Field Value

Name Lead Quality

Caption Lead Quality

Field Quality

Pick Applet Quality Pick Applet

HTML Display Mode (null)

HTML Type (null)
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5 Save the record.

6 In the Object Explorer, drill down under the Applet Web Template node.

7 Select the Edit record only. 

NOTE: The Base mode is enabled for reference purposes only. Any modifications 
to the Base template will be ignored.

8 Modify the Web template for the Edit record by right clicking and selecting Edit 
Web Layout. 

9 Drag the new control to an appropriate placeholder. 

For example, drag the Lead Quality control from the Controls window onto an 
available placeholder in the template editor.

10 Save and close the new Web Layout.

11 Compile and test.

To add a picklist field to the Opportunities persistent filter

The following example shows how you could add the Address picklist to the filter.

1 In Siebel Tools, locate the appropriate applet (for example, FINS Opportunity 
Filter Form Applet).

2 Lock the project.

3 In the Object Explorer, drill down under the Applet node and select Controls.
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4 Add the desired control to the list, with the Name, Caption, Field, Pick Applet, 
and Run Time fields populated with appropriate values.

NOTE: You can use an existing control with a picklist in the filter applet, or the 
control on the base list or form, as a source of comparison. 

For example, Address was added with the following fields and values:

The other fields were left at default values.

5 Save the Record.

6 Drill down on the Applet's Business Component (for example, FINS Opportunity 
Filter).

7 Lock the Project for the business component.

8 Locate the field that you added to the applet. For example, locate Street Address.

9 Delete the field for this business component. 

You will need to delete this field as often as the existing field is a duplicate of 
the base business component (for example, opportunity). The purpose of this 
exercise is to point the field to an empty column in a table for initial population 
when the filter is first rendered in the browser, and not to read and write to the 
business component. As a result, it is simpler to create the control from scratch 
and compare it to an existing picklist filter control. 

Field Value

Name Street Address

Caption Address

Field Street Address

Pick Applet FINCORP Org Address

MVG Applet True

Run Time True
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10 Create the new record on the business component. The properties that need to 
be populated include: 

■ Name (for example, Street Address)

■ Column (choose any column of the same data type—for example, 
DESC_TEXT)

■ PickList (an appropriate picklist)

11 In the Object Explorer, drill down under the Applet Web Template node.

12 Select the Edit mode record only. 

NOTE: The Base mode is active for reference purposes only. Any modifications to 
the Base template will be ignored.

13 Modify the Web template for the Edit record by right-clicking and selecting Edit 
Web Layout. 

14 Drag the new control to an appropriate placeholder. For example, drag the Street 
Address control from the Controls window onto an available placeholder in the 
template editor. 

15 Return to the Applet and select Applet User Properties.

16 Add a record with the following fields: Name: MVG# (must be MVG and any 
number), and Field.

17 Save and close the new Web Layout.

18 Compile and test.

Limitations 
With the exception of some specialized fields that appear preconfigured, there are 
currently no wildcard searches. It is recommended that only LOV's and picklists be 
used.
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The following end-user procedures are described in this section:

■ To add an opportunity

■ To create an opportunity from an application on page 37

■ To enter and run a persistent filter on page 38

■ To save a persistent filter on page 39

■ To delete a persistent filter on page 39

Adding an Opportunity
When end users identify a unique opportunity, they add a new opportunity record. 

To add an opportunity

1 Navigate to the Opportunities screen.

2 From the Show drop-down list, select My Opportunities.

3 In the More Info form, click the show more button, add a record, and complete 
the necessary fields.

Some fields are described in the following table.

Field Comments

Closure Summary Summary comments about the closing of an opportunity. Used 
by financial institutions when closing deals to track the 
circumstances and success or failure of closing.

Commitments A read-only monetary value representing sum of commitments 
made in a commercial loan opportunity. This value is entered 
on the Opportunity Detail, Commercial Loans view. For more 
information, see “Adding Opportunity Details” on page 37.
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Deposits A read-only monetary value representing the sum of deposits 
made in a commercial loan opportunity. This value is entered 
through the Opportunity Detail, Commercial Loans view. For 
more information, see “Adding Opportunity Details” on 
page 37.

Industry Automatically populates with the industry of the company 
associated with the opportunity.

Lead Quality Estimate of the quality of the deal.

Loans A read-only monetary value representing the total amount of 
loans made in a commercial loan opportunity. This value is 
entered through the Opportunity Detail, Commercial Loans 
view. For more information, see “Adding Opportunity Details” 
on page 37.

Probability % The estimate of the likelihood that the opportunity will result 
in business, expressed as a percentage:

■ 0% means it is doubtful that business will result

■ 100% means it is certain that business will result

Product Line Select the product line associated with the opportunity. 

Revenue Enter the amount of money you expect this opportunity to 
generate. When combined with the probability you assign to 
the opportunity, the Expected Value field is calculated.

Sales Cycle Select the current cycle of the opportunity. The total number of 
opportunities in a specific cycle stage and the length of time 
that a particular opportunity has been in that cycle are 
important data for evaluating that opportunity.

Secure Restricts visibility of an opportunity in the All Opportunities 
view to the members of the sales team. Clicking on this check 
box secures the record. Only the primary member of the sales 
team or the Siebel administrator can set the Secure field. To 
make the opportunity visible to every end user in the All 
Opportunities view, leave this field unchecked. 

Start Date Start date for the opportunity.

Field Comments
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Adding Opportunity Details
End users can add details specific to commercial lending, equity, fixed income, 
advisory, and lending syndicate opportunities in the Opportunities Details view tab. 

To add specific opportunity details

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select an opportunity.

3 Click the Opportunity Detail view tab.

4 From the Show drop-down list, select one of the following:

■ Commercial Loan

■ Equity

■ Fixed Income

■ Advisory

■ Lending Syndicate

5 In the appropriate lists, add a record and complete the necessary fields.

Creating an Opportunity from an Application
End users can also create opportunities when they create a financial application.

To create an opportunity from an application

1 Navigate to the Applications screen.

2 From the Show drop-down list, select My Applications.

3 In the Applications list, add a record and complete the necessary fields.

The new application is saved and an opportunity is created. 
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Using Persistent Filters
Persistent list filters provide end users with the ability to filter data in a list based 
on a query-by-example paradigm, but the criteria of the filters are visible and 
editable in the filter even after the filter has been run.

NOTE: Persistent filters are available in selected views in the Opportunities, 
Activities, Event Calendar, Sub-Events, and Sessions views.

To enter and run a persistent filter

1 Navigate to the Opportunities screen.

2 From the Show drop-down list, select All Opportunities.

3 In the Opportunities Filter, create a filter query by filling in the desired fields.

Some fields are described in the following table.

NOTE: The persistent filter fields are cumulative; opportunities must meet every 
criteria defined in the Opportunities filter.

Field Comments

Company Select a company from the Pick Company dialog box.

Expected 
Value

Enter a range. For example, entering >=2000000 would return 
opportunities with an expected value greater than or equal to 
$2,000,000. This field supports query operator use.

Industry Select an industry from the Pick Industry dialog box.

Probability Enter a percentage value or range of values. For example, entering 
>= 50, would return opportunities with a 50% or greater probability. 
This field supports query operator use.

Revenue Enter a range. For example, entering >=2000000 would return 
opportunities with revenue greater than or equal to $2,000,000. This 
field supports query operator use.

Sales Cycle Select a Sales Cycle stage from the drop-down list.
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4 To run the filter query, click Go in the Opportunities Filter.

In the Opportunities list, only those records meeting the persistent filter criteria 
appear. End users can continue to filter the results by making changes to the values 
in the filter fields.

To save a persistent filter

1 Create and run a persistent filter. For more information, see “To enter and run a 
persistent filter” on page 38.

2 Type an appropriate name in the Save Filter As field and click Save or Save as 
Default.

Clicking Save as Default saves a filter query to run as a default every time you 
go to the associated Opportunities view. 

The filter name appears in the Select Filter drop-down list. 

To delete a persistent filter

1 Navigate to the Opportunities view which contains the saved persistent filter.

2 In the Opportunities Filter, select the saved persistent filter you wish to delete 
from the Select Filter drop-down list and click Delete.

The filter is deleted and no longer appears in the Select Filter list.
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Within Siebel eHealthcare, the term companies refers to entities that are typically 
referred to as accounts in other Siebel applications. A company represents the 
relationship between your organization and companies or organizational entities 
(or structures) with which you do business. Use the Companies screen and its 
associated views to view company information and interactions.

CAUTION: This chapter assumes you have renamed Siebel Account objects to 
Companies. By default, Siebel eHealthcare installs using the term Accounts. For 
more information on renaming Siebel Account objects, see the Upgrade Guide for 
your operating system.

Using the procedures given in this chapter, you will be able to perform the 
administrator tasks of controlling company information, generating company 
hierarchies, managing competitor information, verifying coverage team members, 
and managing custom-defined relationship types. 

End users use the Companies views to add new companies, create company 
assessments, associate service requests with a company, update a company 
coverage team, define relationships to other companies, contacts, and households, 
and view company summary information. 

You can save time and reduce keystrokes by using a workflow to automate steps that 
are repeatedly performed by end users. For more information, see Siebel Business 
Process Designer Administration Guide for Financial Services. 
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About Company Hierarchies
A company hierarchy is a group of companies that are organized by parent-child 
relationships. Siebel Industry Applications support displaying these company 
relationships in a hierarchical tree.

The hierarchical tree is a visual representation of company hierarchy data that 
allows end users to view the relationships between companies. By viewing a 
company roll-up, users can see aggregated company information, including 
contacts, coverage teams, activities, and opportunities. 

When end users have access to a company, they can review the hierarchical 
structure for that company, its child divisions, and the contacts that work there. 
Company hierarchies are displayed in five subviews of the Companies screen—
Relationship Hierarchy view, Activity Roll-up, Contact Roll-up, Opportunity Roll-up, 
and Coverage Team Roll-up. 

Depending on your configuration, a company that does not have a parent-child 
relationship with another company may not appear in the roll-up views. 

For more information on company hierarchies, see “Generating Company 
Hierarchies for Data Aggregation” on page 51 and “Viewing Company Hierarchies 
in Roll-up Views” on page 57.
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Business Scenarios
These scenarios feature sample tasks performed by a sales representative in the 
insurance and healthcare industries. Your company may follow a different workflow 
according to its business requirements.

In this scenario, end users are the sales representatives who manage company 
information. They enter information to:

■ Add new companies to the database and create company assessments

■ Associate applications and service requests with a company

■ Manage company coverage teams

■ View company summary information

■ View relationships in a graphical manner

■ Add census information

Sales Representative Tracks Company Information
A sales representative uses the Companies screen to capture and manage profile 
information about her business customer, such as contacts, organizational 
structure, management, and financial information. In addition to viewing market 
statistics and D&B reports. Using Siebel eHealthcare, she can capture and track 
information about a company’s:

■ Relationship with her organization, such as the coverage team, contract terms, 
sales and service information

■ Preferred delivery channels, at both summary and detailed levels

She can also view details of competitors and create and access marketing and sales 
presentations.

The sales representative can create a new company record or view and modify 
information about existing companies. For example, if the sales representative is 
preparing for a sales call, she can use the Companies screen to answer the following 
questions:
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■ What business is this company in?

■ Who are the executives I should be calling on?

■ What is this company’s financial profile?

■ What financial accounts and products does the company already own?

■ What types of service issues has the company had?

Sales Representative Collects Census Data
A licensed sales representative for an insurance company is on the phone with a 
prospective customer who requests a quote for group insurance. In this case, the 
prospective customer is an insurance agent who calls on behalf of a large company 
that wants to offer insurance at group rates to its employees.

After the sales representative gathers information from the agent, he adds a policy 
record in the Group Policies screen. Then, he goes to the Census view to collect 
segmented and detailed census data in preparation for generating a policy proposal.

As he works with the agent, he navigates to a variety of views. He accesses the Plan 
Design view to specify the group plan design and the Proposals view to generate 
proposals. For more information on group policies, see Chapter 10, “Group 
Policies.”
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Companies Sample Tasks
Figure 2 illustrates sample tasks that administrators and end users typically perform 
when managing companies.

Figure 2. Companies Sample Tasks
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Administrator Procedures
The following administrator procedures are described in this section:

■ To make a company unavailable to all other users on page 46

■ To indicate that a company is a competitor on page 47

■ To search for a company without any coverage team members on page 49

■ To add or delete members of the coverage team for a company on page 49

■ To change the primary coverage team member for a company on page 49

■ To add a custom-defined relationship type on page 50

■ To generate a default company hierarchy on page 52

■ To create a dynamic company hierarchy of selected companies on page 53

Deleting Company Information
Deleting a company completely removes the company, as well as all activities 
related to the company, from the system. Only delete a company record if you are 
certain that the company is no longer active. If end users are unsure whether or not 
a company is still active (and therefore should not be deleted), they have the option 
of removing themselves from the company team instead of deleting the record.

As the Siebel administrator, you can make a company unavailable to all other users. 
First, you can assign yourself as the primary team member. Second, you remove all 
other employees from the company’s team. 

To make a company unavailable to all other users

1 From the application-level menu, choose View > Site Map > Data 
Administration > Companies.

2 In the Company list, select a company.

3 In the Company form, click the select button in the Coverage Team field. 

The Coverage Team dialog box appears.
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4 In the Coverage Team dialog box, locate the administrator and click in the 
Primary field.

A check mark appears in the Primary field.

5 In the Coverage Team dialog box, delete all other coverage team members and 
click OK.

Only those users with access to the All Companies and All Companies Across 
Organizations views will be able to see this company. 

Managing Competitor Information
Effective sales and marketing requires that your employees have up-to-date and 
consistent information about the competition and their products. This section 
describes how to administer information about competitors and competitive 
products within the Companies screen. 

To indicate that a company is a competitor

1 From the application-level menu, choose View > Site Map > Data 
Administration > Companies.

2 In the Company list, add or select a company.

3 In the Company form, click the show more button.

4 Select the Competitor check box to add the company to the Competitor’s list.

The company appears in the Competitor’s list. The Competitor’s list is available 
in the Competitors screen and related screens, such as Opportunities.

NOTE: Non-administrators can specify that a company is a competitor by selecting 
Competitor from the Type drop-down list. However, selecting Competitor from the 
Type drop-down list does not add the company to the Competitor’s list as seen on 
the Competitor’s screen or in the Pick Competitors dialog box, which is accessible 
on related screens, such as Opportunities. 
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When a company has been indicated as a competitor, you may want to add 
document files of comparative and competitive literature. For more information, see 
the chapter on literature administration in Siebel Applications Administration 
Guide.

Competitor Information
You cannot delete records that have been added to the Competitors list, since 
deleting them would also remove them from related screens, like Opportunities. For 
example, a company may have been a competitor for an opportunity last month. 
Even if the company is no longer a competitor, the competitor record should remain 
as part of the history of the opportunity. 

If you no longer want a record to appear in the Competitor’s list, uncheck the 
Competitor check box. This removes the record from the Competitors screen 
without affecting other screens.

Verifying Coverage Team Members
If you are logged on as a Siebel administrator, you can search for companies that do 
not have any coverage team members.

Managers can add or delete the members of a company’s coverage team if they are 
the existing primary team member, or the primary team member is one of their 
direct reports. If you are logged in as an administrator, you can change the primary 
team designate for any company in the Company Administration view (From the 
application-level menu, choose View > Site Map > Data Administration > 
Companies).

The procedures that follow involve making selections in the Coverage Team field. If 
the Coverage Team field does not appear in your installation, you may need to 
reveal it using the Columns Displayed dialog box.

NOTE: Usually, Assignment Manager resolves problems with coverage teams and 
owner assignment automatically. For more information on Assignment Manager, 
see Siebel Assignment Manager Administration Guide.
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To search for a company without any coverage team members

1 From the application-level menu, choose View > Site Map > Data 
Administration > Companies.

2 In the Companies list, define a New Query where the Coverage Team field equals 
IS NULL.

NOTE: If the Coverage Team field does not appear, you may need to reveal it using 
the Columns Displayed dialog box.

3 Execute the query.

The query returns a list of all companies which do not have any coverage team 
members.

To add or delete members of the coverage team for a company

1 From the application-level menu, choose View > Site Map > Data 
Administration > Companies.

2 In the Companies list, select a company.

3 In the Company form, click the select button in the Coverage Team field. 

The Coverage Team dialog box appears.

4 To add or delete coverage team members:

■ To add a member to the coverage team, click New, select an employee in the 
Coverage Team dialog box, and click OK.

■ To delete an employee from the team, select the employee in the list and click 
Delete.

To change the primary coverage team member for a company

1 From the application-level menu, choose View > Site Map > Data 
Administration > Companies.

2 In the Companies list, select a company.
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3 In the Company form, click the select button in the Coverage Team field. 

The Coverage Team dialog box appears.

4 Select the Primary field for the new primary coverage team member and click 
OK.

Managing the Custom-Defined Relationship Types LOV
If you are logged in as the Siebel administrator, you can create and maintain a list 
of predefined custom-defined relationship types. A default list of values is provided 
with the application. These relationship types appear in the drop-down LOV for the 
Type field found on the Relationship Hierarchy views, in the Party Relationship 
applet.

To add a custom-defined relationship type

1 From the application-level menu, choose View > Site Map > Application 
Administration > List of Values.

2 In the List of Values list, create a New Query where Type equals 
PARTY_RELATIONSHIP_TYPE.

At least six records will be returned, showing the existing list of values for 
custom-defined relationship type.

3 In the List of Values list, add a record and complete the necessary fields. 

Some fields are described in the following table.

Field Comments

Active Determines whether the value is displayed to the end user in 
the Relationship drop-down list. 

Display Value Value as displayed in the Relationship drop-down list.

Language 
Independent Code

Code used internally by the Siebel application.

Language Name Language used for the list of values Display Value field.
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NOTE: You cannot delete LOV table entries. Use the Active check box to deactivate 
an LOV entry and thereby remove it from the Relationship drop-down list.

Generating Company Hierarchies for Data Aggregation
Data aggregation is available by using the Roll-up views provided the administrator 
defines one or more hierarchies. The application administrator typically defines a 
default hierarchy by associating accounts with one another using the parent field 
on a company form, or the subaccount view for child accounts. Administrators can 
define Company hierarchies to display aggregated data—the activities, 
opportunities, contacts, and coverage teams—across organizational structures. For 
example, the top node of the hierarchy contains activities for the organization, the 
subsidiaries below the organization, the departments at the subsidiaries, and 
contacts working at any level of the tree. As the end users move up and down the 
tree, they see more or less data rolled up to the selected level.

The application administrator can define two types of hierarchies for data 
aggregation—a default hierarchy for all end users and specific hierarchies that are 
used only by certain end users.

Order Numerical order in which a value is displayed within the 
Relationship drop-down list.

Parent LIC Language-independent code of a parent list of values. It is used 
in hierarchical list of values.

Translate When checked, indicates that the list of values is part of a 
multilingual list of values (MLOV).

Type The type of list of values. For this procedure, select 
PARTY_RELATIONSHIP_TYPE.

Field Comments
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Default Company Hierarchies
The application administrator sets up a default company hierarchy once, during the 
initial application setup. The default hierarchy is available to all end users who are 
not tied to a specific hierarchy and who have been granted view access to the 
companies represented in the hierarchy. It is the administrator’s responsibility to 
give end users access to Company views. For more information, see Siebel 
Applications Administration Guide.

When new companies are added, they are automatically added to the default 
hierarchy tree and the contacts, coverage teams, activities, and opportunities that 
are associated with the company are automatically displayed in the roll-up views. 

In the preconfigured application, using the Generate Hierarchy button adds only 
parent account and child companies to the hierarchy. Any company that does not 
have a child or parent is not displayed in the roll-up views. In Siebel Tools, you can 
change the DynHierarchy LoadAllAccounts user property to alter this behavior.

The DynHierarchy LoadAllAccounts user property on the Dynamic Hierarchy Direct 
Relationship business component can be set to N or Y. When it is set to N, only 
parent and children appear in the a generated hierarchy. When DynHierarchy 
LoadAllAccounts user property is set to Y, all companies are added to the generated 
hierarchy. For more information on setting user properties, see Siebel Tools 
Reference.

To generate a default company hierarchy

1 In the application-level menu, choose View > Site Map > Application 
Administration > Account Hierarchies.
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2 In the Account Hierarchies list, click Generate Hierarchy.

The parent-child account relationships that have been defined in your 
application are registered for participation in the roll-up views. This process may 
take some time, depending on the quantity of account records that are in your 
existing environment.

When the company hierarchy has been generated, a new record appears in the 
Company Hierarchies list. The Hierarchy Name field of the record contains the 
user Id of the administrator who generated the hierarchy and the time it was 
generated. If it is the only hierarchy record, the Default field is automatically 
checked. The companies that have been added for participation in the roll-up 
views appear in the Company Relationships list.

NOTE: If no accounts are visible in the Company Relationships list, click the 
query button, step off the query, and click Go to refresh the view.

3 Optional. Rename the company hierarchy and, if necessary, check the Default 
field.

NOTE: If end users are using the application when you generate a hierarchy, they 
must log off and log on again to see the default hierarchy in the roll-up views.

Dynamic Company Hierarchies
In some cases, users work with particular companies within a large corporation, but 
not with others. In these instances, some end users do not need to or should not see 
aggregated data across the entire corporation. An administrator can define a custom 
hierarchical structure across which data can be aggregated. This defined structure, 
called a dynamic hierarchy, can be as simple or complex as needed and offers users 
the ability to aggregate data across the companies they are interested in seeing. 

To create a dynamic company hierarchy of selected companies

1 In the application-level menu, choose View > Site Map > Application 
Administration > Company Hierarchies.

2 Create a new company hierarchy record.
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3 Click the Add button in the Company Relationships list, select companies in the 
Add Company dialog box, and click OK.

All the accounts in the Company Relationship list belong to the new account 
hierarchy.

4 To define parent and child relationships, select an company in the Company 
Relationship list that has no parent, click the select button in the Parent 
Company field, and select a parent company in the Pick Parent Company dialog 
box.

5 Repeat Step 4 for all companies that have no parents.

6 Associate the dynamic hierarchy with an organization.

End users can only see the hierarchy with which their current position’s primary 
organization is tied. It is the administrator’s responsibility to associate end users 
with positions, positions with organizations, and organizations with hierarchies. 
For more information, see Siebel Applications Administration Guide
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End-User Procedures
The following end-user procedures are described in this section:

■ Adding a Company

■ To add a company on page 56

■ Viewing Company Hierarchies in Roll-up Views

■ To view aggregated activities for a company on page 57

■ To view the aggregated coverage team for a company on page 58

■ To view aggregated opportunities for a company on page 58

■ To view an aggregated list of contacts for a company on page 59

■ Creating Assessments for a Company

■ To perform a company assessment on page 59

■ To view the results of a company value assessment on page 60

■ Associating Applications with a Company

■ To associate an application with a company on page 61

■ Associating a Service Request with a Company

■ To add a service request associated with a company on page 62

■ Managing a Company Coverage Team

■ To add a member to a coverage team on page 63

■ Viewing a Company Summary

■ To view company summary information on page 63

■ Viewing a Company Relationship Hierarchy

■ To establish a natural parent-subsidiary relationship between two 
companies on page 65

■ To create a custom-defined relationship on page 65
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■ Adding Census Information

■ To add census information in the Companies screen on page 67

Adding a Company
When end users identify a possible lead, the lead can be added as a company. Users 
can then begin to add and track information about the company.

To add a company

1 Navigate to the Companies screen.

2 From the Show drop-down list, select My Companies.

3 In the Companies form, click the show more button, add a record, and complete 
the necessary fields.

United States law requires that financial institutions disclose their privacy 
policies regarding the sharing of non-public personal information with third 
parties and fair credit reporting that impacts the sharing of non-public personal 
information with affiliates. End users can specify a privacy level by making a 
selection from the Privacy Option field.

4 To specify a privacy level, scroll down to the Privacy Option field and select one 
of the following:

■ Opt-In. Sharing of non-public personal information is allowed without 
restrictions.

■ Opt-Out - Affiliates. Sharing of non-public personal information with affiliates 
is not allowed.

■ Opt-Out - Third Party. Sharing of non-public personal information with third 
parties is not allowed.
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■ Opt-Out - All Parties. Sharing of non-public personal information with any 
affiliate or third party is not allowed.

NOTE: If you have administrator privileges, you can also add companies from the 
application-level menu, by choosing View > Site Map > Data Administration > 
Companies.

Viewing Company Hierarchies in Roll-up Views
End users can review the company and its parent organization, subsidiaries, 
contacts, opportunities and relationships to other entities in the graphical 
relationship hierarchy tree control available in the roll-up views. By drilling down 
on hypertext links on the hierarchy tree, end users can navigate to related views.

NOTE: If the company has not been added to a hierarchy tied to the user's position's 
organization (either default hierarchy or dynamic hierarchy), the hierarchy tree is 
not visible to the end user. Instead they the following message: “The selected record 
is not included as part of your defined hierarchy. If you feel this is in error, please 
contact your system administrator.” The administrator is responsible for associating 
positions with organizations and an organization with a hierarchy.

The Activities-Roll-up view shows all of the activities associated with the selected 
company and its children. End users can apply filters to the list to find specific 
activity records and save the filtered list.

To view aggregated activities for a company

1 Navigate to the Companies screen> My Companies.

2 Select a company and click the Activities-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All activities 
associated with the company and all of its children appear in the Activities-Roll-
up list. 

In the Activities-Roll-up List, you can:
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■ Drill down on an activity type to navigate to the Activities > Attachments 
view.

■ Drill down on a company name to navigate to the Companies > Contacts 
view.

NOTE: If you create an activity in the Activities screen and do not set the 
Company field, the activity will not appear in the Activities-Roll-up list.

To view the aggregated coverage team for a company

1 Navigate to the Companies screen > My Companies.

2 Select a company and click the Coverage Team-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All coverage 
team members associated with the company and all of its subsidiaries appear in 
the Coverage Team-Roll-up list.

In the Coverage Team-Roll-up list, you can:

■ Drill down on a last name to navigate to the Employees screen.

■ Drill down on an email address to open a blank email message addressed to 
the team member who has that address.

To view aggregated opportunities for a company

1 Navigate to the Companies screen > My Companies.

2 Select a company and click the Opportunities-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All 
opportunities associated with the company and all of its children appear in the 
Opportunities-Roll-up list.

In the Opportunities-Roll-up list, you can:

■ Drill down on an opportunity name to navigate to the Opportunities screen.

■ Drill down on an company name to navigate to the Companies >Contacts 
view.
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To view an aggregated list of contacts for a company

1 Navigate to the Companies screen > My Companies. 

2 Select a company and click the Contact-Roll-up view tab.

The associated hierarchy appears on the right side of the screen. All contacts 
associated with the company and all of its children appear in the Contacts-Roll-
up list.

In the Contacts-Roll-up list, you can:

■ Drill down on a last name to navigate to the Contacts screen.

■ Drill down on an company name to navigate to the Companies >Contacts 
view.

■ Drill down on an email address to open a blank email message addressed to 
the contact who has that address.

Creating Assessments for a Company
An assessment is a set of attributes used to assess the business potential or credit 
worthiness of a company. Company assessments can be used to compare 
companies to each other or against a model, or to learn about companies and sales 
situations. End users complete the company assessment by selecting the 
appropriate values for the different attributes.

To perform a company assessment

1 Navigate to the Companies screen.

2 From the Show drop-down list, select My Companies.

3 In the Companies list, select the company for which the assessment is being 
performed.

4 Click the Assessments view tab.

5 In the Assessments list, add a record.

6 In the Template Name field, click the select button.

The Select Assessment Template dialog box appears.
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7 In the dialog box, select the appropriate template and then click OK.

Attribute records are automatically generated in the Assessment Attributes list. 

8 In the Assessment Attributes list, make a selection in the Value field for each 
attribute and then click OK.

For more information viewing assessments, see “Viewing the Results of a Company 
Value Assessment” on page 60.

NOTE: Administrators must create the assessment templates. See Siebel Applications 
Administration Guide for more information on how to create assessment templates.

Viewing the Results of a Company Value Assessment
A company value assessment evaluates a company based on criteria defined by an 
end user's organization. The results of a company value assessment appear in the 
form of a Customer Value icon. This icon appears in the Company Summary and 
gives users an instant summary of the value of the company to the financial 
institution. Each star represents a quartile value. For example, one star means 1% 
to 25% and two stars mean 25% to 50%. This four-star system allows the user to 
determine the value of a company without having to perform complex research and 
analysis.

To view the results of a company value assessment

1 Navigate to the Companies screen.

2 From the Show drop-down list, select My Companies.

3 In the Companies list, select a company for which you want to view the results 
of a company value assessment.

4 Click the Summary view tab.

The Company Summary view appears. Each star in the Customer Value icon 
represents a quartile value.
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Associating Applications with a Company
Applications are used for companies that want to apply for offered services or 
products. For example, a small business wants to apply for a business checking 
account. The end user handling the inquiry finds the company in the All Companies 
view, navigates to the Applications view, and creates an application record for this 
business checking account application. 

To associate an application with a company 

1 Navigate to the Companies screen.

2 From the Show drop-down list, select All Companies.

3 In the Companies list, select the company to associate with an application.

4 Click the Applications view tab.

The applications associated with that company appear. 

5 In the Applications list, add a record and complete the necessary fields.

NOTE: To enter more detailed application information, drill down on the Application 
Name hyperlink.

Associating a Service Request with a Company
A service request is a request from a company for information or assistance with a 
problem related to purchased products or services. When a customer calls about an 
existing service request, end users can find the service request and give status 
information to the caller in several ways. They can:

■ Review the service request information

■ Create an activity to record the customer’s call

■ Update the service request with additional information from the customer

■ Resolve the service request

■ Assign the service request 
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■ Transfer the caller to another service representative

If a call requires that an end user create a new service request, she can create one. 
Siebel eHealthcare automatically assigns a unique service request (SR) number to 
track the new service request throughout the system.

To add a service request associated with a company

1 Navigate to the Companies screen.

2 From the Show drop-down list, select All Companies.

3 In the Companies list, select a company.

4 Click the Service Requests view tab.

The service requests associated with that company appear. 

5 In the Service Requests list, add a record and complete the necessary fields.

The application automatically assigns a service request number (SR#).

Managing a Company Coverage Team
A coverage team is the group of employees that are assigned to manage the 
relationship with a given company. The coverage team for a company is defined as 
all users who have access to the company in the My Companies view. 

NOTE: Similar coverage team functionality is also available for contacts. You can use 
the Contact Coverage Team view (Contacts > Coverage Team) to manage the 
contact coverage team.

End users can use the company coverage team functionality available in 
Siebel eHealthcare to:

■ Record and display employees covering a company within a single company 
record

■ Specify and review the nature of the employee's relationship with each covered 
company, defined as the Coverage Role and Attributes list
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To add a member to a coverage team

1 Navigate to the Companies screen.

2 From the Show drop-down list, select My Companies.

3 In the Companies list, select a company.

4 Click the Coverage Team view tab.

5 In the Coverage Team list, add a record. 

6 In the Add Employees dialog box, select an employee and click OK.

7 If known, select the employee’s coverage role using the drop-down list in the 
Coverage Role field.

NOTE: The Siebel administrator maintains the Coverage Role LOV in the List of 
Values screen under the Type field value type FINS_COVERAGE_ROLE_TYPE. To 
access the List of Values screen select View > Site Map > Application 
Administration > List of Values.

8 If desired, use the Categories and Securities list to select values defining the 
coverage relationship between the employee and the company; you can select 
one or more attributes. 

The application adds the employee to the coverage team with a defined 
relationship. The company will appear in the employee’s My Companies view.

Viewing a Company Summary
The Company Summary view provides a comprehensive view of a company in an 
editable format. This view displays basic company information, financial accounts, 
call reports, logged alerts, and contacts associated with a company. 

The Customer Value icon in the Company form indicates the company’s value to 
the organization. For more information, see “Creating Assessments for a Company” 
on page 59.

To view company summary information

1 Navigate to the Companies screen.
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2 From the Show drop-down list, select All Companies.

3 In the Companies list, select a company.

4 Click the Summary view tab.

For more information on editing summary view information, see “Configuring 
Summary Views” on page 21.

Viewing a Company Relationship Hierarchy
End users use the Company Relationship Hierarchy to identify and capture key 
relationships for a company. This view features a graphical tree that provides a 
visual representation of a company’s relationships. The tree shows the natural 
hierarchy of a company’s parent-child relationships to entities such as companies, 
subsidiaries, divisions, contacts, and coverage relationships with employees as well 
as custom-defined relationships.

Custom-defined relationships are ad-hoc associations between the company and 
any contact, organization, household, or employee. End users can record custom-
defined relationships between any two entities in the adjacent Party Relationships 
list.

NOTE: The Relationship Hierarchy view is also available on the Contacts, Employee 
(read only) and Households screens. For more information, see “Viewing a Contact 
Relationship Hierarchy” on page 83 and “Viewing a Household Relationship 
Hierarchy” on page 95.
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To establish a natural parent-subsidiary relationship between two companies

1 Navigate to the Companies screen.

2 From the Show drop-down list, select My Companies.

3 In the Companies list, select the company to be established as the subsidiary.

4 In the More Info form, click the show more button.

5 In the Parent field, click the select button.

The Pick Company dialog box appears.

6 In the Pick Company dialog box, select the parent company and click OK.

The name of the selected company appears in the Parent Organization field.

7 Repeat Step 3 through Step 6 to set up companies, subsidiaries, branches, and 
departments as needed for your deployment.

8 Click the Relationship Hierarchy view tab.

The new parent-subsidiary relationship is shown in the Relationship Hierarchy 
explorer in the lower-left corner of the screen.

NOTE: An alternative approach would be to select the parent companies and 
select the Subaccount view to add children.

To create a custom-defined relationship

1 Navigate to the Companies screen.

2 From the Show drop-down list, select My Companies.

3 In the Companies list, select the company for which you want to create a 
custom-defined relationship.

4 Click the Relationship Hierarchy view tab.
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5 In the Party Relationship list, add a record and complete the necessary fields. 

Some fields are described in the following table.

The newly defined relationship appears in the Relationship Hierarchy explorer.

Adding Census Information 
In addition to adding census information in the Group Policies screen, end users 
also add census information on the Companies screen for companies that request a 
quote or proposal for a group insurance policy. 

To add census information, end users must:

■ Add a policy in the Group Policies screen. For more information, see “Adding 
Policy Records” on page 139.

Field Comments

Relationship Categorizes the relationship between the company and another 
entity. Field has an LOV for custom-defined Relationship values. 
Predefined values include Reports To, Spouse, Child, Lawyer, Board 
Member, Primary Contact (Backup), Admin Assistant, Competitor, 
Referral, Service Provider, Investor, Wealth Management Rep, 
Related Subsidiary, Bank Attorney, Trustee Attorney, and Debtor 
Attorney.

This LOV can be modified by the Siebel administrator. For more 
information, see “Managing the Custom-Defined Relationship 
Types LOV” on page 50.

Start Date

End Date

If the custom-defined relationship falls between the Start and End 
Dates, it appears in the tree. If it falls outside the range, it does not 
appear to the user. The user can enter a start or end date, or both.

Type Use this field to determine the type of entity with which you wish 
to establish a relationship. Defaults to Contact. Other values include 
Household, Organization, and Employee.

Value The value in this field is based on the Type field. For example, if 
Type equals Contact, then clicking the select button in Value field 
displays the Select Contact dialog box.
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■ Add census information using the instructions below, or by using the Group 
Policies, Census view tab. For more information, see “Adding Census 
Information in the Group Policies Screen” on page 140. 

■ Navigate to the Group Policies screen and associate the census with the policy. 
For more information, see “Associating a Census with a Policy” on page 141.

To add census information in the Companies screen

1 From the application-level menu, choose View > Site Map > Companies > My 
Companies.

2 In the Companies list, select a company.

3 Click the Census view tab.

4 In the Census list, from the Show drop-down list, select Segmented Census or 
Detailed Census.

■ Segmented Census. Allows you to add information for groups of employees.

■ Detailed Census. Allows you to add information for individual employees.

NOTE: After adding one type of census information, you can select the other type 
from the Show drop-down list and add information for it.

5 In the Census list, click New.

6 In the new record, complete the fields.

7 Perform the appropriate task from the following list:

■ If you selected Segmented Census, scroll down to the Employee Count list.

❏ In the Employee Count list, click New.

❏ Complete the fields.

■ If you selected Detailed Census, scroll down to the Employee List list.

❏ In the Employee List list, click New.

❏ Complete the fields.
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Contacts are entities or individuals with whom the company does business or with 
whom it expects to do business in the future. Contacts can be employees of other 
companies, independent consultants, vendors, or personal acquaintances. Contacts 
can belong to only one company, but they can be part of many opportunities, 
including opportunities that do not involve their companies. Within 
Siebel eHealthcare, contacts are presented in a single view of the customer and your 
relationship with the customer.

CAUTION: This chapter assumes you have renamed Siebel Account objects to 
Companies. By default, Siebel eHealthcare installs using the term Accounts. For 
more information on renaming Siebel Account objects, see the Upgrade Guide for 
your operating system.

Using the procedures given in this chapter end users can enter and track 
information about contacts, including products bought, details of signed 
agreements or contracts, and products previously recommended to the customer. 
Users can also document marketing campaigns and details of each customer’s 
response. Users can maintain a history of service requests, insurance claims, and 
product applications that the customer has made in the past. They can analyze a 
customer’s financial health as well as a customer’s needs.

The Contacts screen provides an alternative view of data that is available in other 
screens. Many tasks that can be performed in the Contacts views can also be 
performed in other screens. For example, users can create activities for a contact 
either in the Contact Activities view, or they can go to the My Activities view to 
enter a new activity, and then associate it with the contact.

For more information on basic contact functionality and administration, see Siebel 
Call Center User Guide, Siebel Sales User Guide, and Siebel Applications 
Administration Guide.
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You can save time and reduce keystrokes by using a workflow to automate steps that 
are repeatedly performed by end users. For more information, see Siebel Business 
Process Designer Administration Guide for Financial Services. 
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These scenarios feature sample tasks performed by a sales representative in the 
healthcare industry. Your company may follow a different workflow according to its 
business requirements. 

Sales Representative Adds a New Contact
At conference a new account representative meets a potential customer. The 
potential customer gives the new account representative his business card and 
informs her that he had recently moved to the area and works for a medium sized 
software company.

The new account representative returns to her office and enters her new 
acquaintance into the Siebel eHealthcare as a new contact. She can also enter his 
company information and associate the company with the contact. In the 
Relationship Hierarchy view, she can enter the relationships for this contact, 
including all companies he is associated with, the contact's business partners, 
lawyer, his family members, and other influential relationships. As the creator of 
this new contact record, she is automatically added to the coverage team as the 
primary representative for the customer. If necessary, she can also add the small 
business manager and other product experts to the coverage team so they can see 
this new contact in their My Contacts view. 

As the customer is looking for personal and business services, the account 
representative can create separate opportunity records in Siebel eHealthcare 
associated with the contact. In the opportunity records, she records the products 
and services the customer is interested in as well as other follow-up activities to 
serve the customer's needs.

In the scenario, end users are the new account representatives who manage 
company information in the field. They enter information to:

■ Add a new contact and associate him/her with companies

■ Use the Relationship view to enter all the contact's influential relationships

■ Add other account representatives to the coverage team

■ Create new opportunities associated with the contact
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■ Create follow-up activities and assign them to the right representatives to close 
the potential opportunities
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Contacts Sample Tasks
This section details sample tasks often performed by end-users when working with 
contacts. Your company may follow a different workflow according to its business 
requirements. 

End-User Procedures
The following list shows tasks end users typically perform when working with 
contacts. These tasks can be performed in any order.

■ Manage contact information. For more information, see “Managing Contact 
Information” on page 75.

■ Create customer value assessment. For more information, see “Creating a 
Customer Value Assessment” on page 81.

■ View a contact summary. For more information, see “Viewing a Contact 
Summary” on page 82.

■ View relationship hierarchy information. For more information, see “Viewing a 
Contact Relationship Hierarchy” on page 83.

■ Create and use a Book of Clients. For more information, see “Creating and Using 
a Book of Clients” on page 85.
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The following end-user procedures are described in this section:

■ Managing Contact Information

■ To add a contact on page 75

■ To associate a contact with a company on page 76

■ To add a category to a contact on page 77

■ To create a note regarding a contact on page 78

■ To enter a referral received to or from a contact on page 79

■ To create a referral to a contact on page 80

■ Creating a Customer Value Assessment

■ To create a customer value assessment on page 81

■ To view the results of a customer value assessment on page 82

■ Viewing a Contact Summary

■ To view contact summary information on page 83

■ Viewing a Contact Relationship Hierarchy

■ To view a contact’s relationship hierarchy on page 83

■ To define a relationship between contacts on page 84

■ Creating and Using a Book of Clients

■ To create a book of clients on page 85

■ To evaluate a book of clients on page 85
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Managing Contact Information
Contacts are entities or individuals with whom the company currently does 
business or with whom it expects to do business in the future. End users manage 
contact information by:

■ Adding new contacts (See “Adding Contacts” on page 75)

■ Creating contact categories and notes (See “Creating Categories for Contact 
Information” on page 77 and “Creating Notes About a Contact” on page 78)

■ Managing contact referral information (See “Managing Contact Referral 
Information” on page 79)

Adding Contacts
When end users meet someone in the course of business, they add a contact record 
for that individual to track pertinent personal information and possible potential 
future business.

NOTE: The My Personal Contacts view is different from the other Contacts views 
because it is designed for contacts not associated with a company. Therefore, in the 
My Personal Contacts view, adding a company to a record does not also add it to 
the My Contacts view, All Contacts view, and so on. End users must add business 
contacts in the My Contacts view proper. They must create, review, and manage 
activities for their personal contacts only in the Activities view of the My Personal 
Contacts view, not in the other Contacts views.

To add a contact

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select All Contacts.
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3 In the Contacts form, click the show more button, add a record, and complete 
the necessary fields.

United States law requires that financial institutions disclose their privacy 
policies regarding the sharing of non-public personal information with third 
parties and fair credit reporting that impacts the sharing of non-public personal 
information with affiliates. End users can specify a privacy level by making a 
selection from the Privacy Option field.

4 To specify a privacy level, scroll down to the Privacy Option field and select one 
of the following:

■ Opt-In. Sharing of non-public personal information is allowed without 
restrictions.

■ Opt-Out - Affiliates. Sharing of non-public personal information with affiliates 
is not allowed.

■ Opt-Out - Third Party. Sharing of non-public personal information with third 
parties is not allowed.

■ Opt-Out - All Parties. Sharing of non-public personal information with any 
affiliate or third party is not allowed.

To associate a contact with a company

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select a contact.

4 In the More Info form, click the show more button.

5 In the Company field, click the select button.

6 In the Company dialog box, click New, select a record from the Add Companies 
list, and then click OK.

The application automatically associates the company with the contact and 
populates the address with the default company address information. 

7 To enter an alternate address, click the select button in the Address Line field.

The Contact Addresses dialog box appears.
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8 Click New, enter the new address, and then click Save.

The Contact Addresses dialog box displays the new company address.

9 To specify an address as the contact’s primary address, click the Primary field 
and click OK.

NOTE: The last address highlighted in the Companies Addresses dialog box 
appears in the Address Line field. 

10 In the Time Zone field, select the contact’s time zone.

Creating Categories for Contact Information
If the default Contacts list and More Info form do not contain fields to track the type 
of information that end users need to track, they can add additional categories. A 
manager may have set up a list of values from which they can select.

To add a category to a contact

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select a contact.

4 Click the Categories view tab.

5 In the Categories list, add a record.

6 In the Category field, click the select button.

The Pick Category dialog box appears.

7 Select a category from the list of values and click OK, or click New and create a 
new category.

8 Complete the necessary fields.

9 Create additional categories by repeating Step 5 through Step 8.
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Creating Notes About a Contact
As end users work with contacts, they learn things they may want to remember. 
Often these tidbits of information are best stored as notes. Users can create notes 
that everyone with access to the contact record can see, or they can create notes 
that only they can see.

To create a note regarding a contact 

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, either select the contact for whom you wish to create a note 
or create a new contact.

NOTE: If the contact does not exist, add it. For more information, see “Adding 
Contacts” on page 75.

4 Click the Notes view tab.

5 From the Show drop-down list, select one of the following:

■ Public Notes—Notes that others can see.

■ Private Notes—Notes that only their creators can see.

6 In the Notes list, add a record and complete the necessary fields. 

Some fields are described in the following table.

Field Comments

Created Date Automatically populates with a date and time stamp.

Type Default value is Note. Select alternate value to categorize the type 
of note.

Description Text field for the content of the note.
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Managing Contact Referral Information
The Referrals view tab allows end users to enter referral information associated with 
contacts. Referrals are potential opportunities. 

In the Referrals tab view, end users can record both referrals they give to their 
contacts as well as referrals received from a contact.

To enter a referral received to or from a contact

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select the contact for whom you wish to log a referral.

4 Click the Referrals view tab.

5 From the drop-down list, select Referrals From This Contact. 

6 In the list, add a record and complete the necessary fields. 

Some fields are described in the following table.

Field Comments

Company Select an existing company or create a new one. The company 
selected represents the potential opportunity for your 
organization.

Last Name Select a contact to associate with the referral company as 
selected in the Company field; if you entered a Company, the 
list of Contacts is restricted to those associated with the 
selected company.

To create a new company for a referral:

1 On the Contacts screen, create contacts for the company. 
For more information, see “To add a contact” on page 75.

2 Associate those contacts with the new company. For more 
information, see “To associate a contact with a company” 
on page 76.

3 On Referrals view tab, select the Contact from the Pick 
Contact dialog box associated with this field.

Referred By Select the employee who made the referral. 
Version 7.5, Rev. A Siebel eHealthcare Guide 79



Contacts

End-User Procedures
To create a referral to a contact

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select the contact for whom you wish to create a referral.

4 Click the Referrals view tab.

5 Scroll down to Referrals to This Contact list.

6 In the list, add a record and complete the necessary fields. 

Some fields are described in the following table.

Field Comments

Disposition The status of the referral.

Company Select an existing company or create a new one. The company 
selected represents the potential opportunity for your service 
provider.

Last Name Select a contact to associate with the referral company as 
selected in the Company field; if you entered a Company, the 
list of Contacts is restricted to those associated with the 
selected company.

To create a new company for a referral:

1 On the Contacts screen, create contacts for the company. 
For more information, see “To add a contact” on page 75.

2 Associate those contacts with the new company. For more 
information, see “To associate a contact with a company” 
on page 76.

3 On Referrals view tab, select the Contact from the Pick 
Contact dialog box associated with this field.

Referred By Select the employee from your organization who made the 
referral. 
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Creating a Customer Value Assessment
The Contacts Assessments view can help end users qualify contacts and verify 
resource allocation. Contact assessments are created in the Contacts Assessments 
view and the results are presented in the Contacts Summary view. 

NOTE: A similar assessment functionality is available for companies. For more 
information, see “Creating Assessments for a Company” on page 59.

A customer value assessment evaluates a contact based on defined criteria. Each 
assessment template has a group of assessment attributes that make up the different 
measurement points of the assessment. A Siebel administrator can create new 
templates and add or modify assessment attributes. For more information on 
assessment templates and how to define and manage them, see Siebel Applications 
Administration Guide.

NOTE: Siebel administrators who wish to modify the Customer Value assessment 
template must name the template Customer Value. If they do not use this name, the 
Customer Value icon will not display the appropriate information.

To create a customer value assessment

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select the contact for whom the assessment will be added.

4 Click the Assessments view tab.

5 In the Assessments list, add a record.

6 In the Template Name field, click the select button.

7 In the Select Assessment Template dialog box, select a Template Name and click 
OK. 

Assessment attributes, as defined for the Customer Value template, are 
automatically created in the Assessment Attributes list.

8 In the Assessment Attributes list, where possible, select a value for each 
attribute by clicking the select button in the Value field.
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Viewing the Results of a Customer Value Assessment
A customer value assessment evaluates a customer based on criteria defined by an 
end user's organization. The results of a customer value assessment appear in the 
form of a Customer Value icon. This icon appears in the Contact Summary and gives 
users an instant summary of the value of the customer to the financial institution. 
Each star represents a quartile value. For example, one star means 1% to 25% and 
two stars mean 25% to 50%. This four-star system allows the user to determine the 
value of a specific contact without having to perform complex research and 
analysis.

To view the results of a customer value assessment

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select the contact for whom you want to view the results of 
a customer value assessment.

4 Click the Summary view tab.

The Contact Summary view appears. Each star in the Customer Value icon 
represents a quartile value.

NOTE: When multiple customer value assessments exist, only the data from the last 
customer value assessment completed is displayed.

Viewing a Contact Summary
The Contact Summary view provides a comprehensive view of a contact’s 
relationship with an end user’s organization in an editable format. This view 
displays the customer’s contact information, financial accounts, applications, alerts, 
campaigns targeted at the customer, and service requests and opportunities 
associated with the customer. 

The Customer Value icon in the Contact form indicates the customer’s value to the 
organization. For more information, see “Creating a Customer Value Assessment” 
on page 81 and “Viewing the Results of a Customer Value Assessment” on page 82.
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To view contact summary information

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select a contact.

4 Click the Summary view tab.

For more information on editing summary view information, see “Configuring 
Summary Views” on page 21.

Viewing a Contact Relationship Hierarchy
A contact’s relationships are those of influence. End users may have a contact who 
relies heavily on the opinions of others when making purchasing or other decisions. 
If so, they may want to keep track of the relationships between a contact having 
purchasing authority and those who might influence his purchasing decisions.

End users use the Contacts Relationship Hierarchy view to identify and capture key 
relationships for a contact. This view features a graphical tree that provides a visual 
representation of a contact’s relationships. The tree displays both the natural 
hierarchy of a contact’s parent-child relationships to entities such as companies and 
households, as well as custom-defined relationships.

Custom-defined relationships are ad-hoc associations between the contact and any 
other contact, organization, or household. End users can record custom-defined 
relationships between any two entities in the adjacent Party Relationships list.

NOTE: The Relationship Hierarchy view is also available on the Companies and 
Households screens. For more information, see “Viewing a Company Relationship 
Hierarchy” on page 64 and “Viewing a Household Relationship Hierarchy” on 
page 95.

To view a contact’s relationship hierarchy

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.
Version 7.5, Rev. A Siebel eHealthcare Guide 83



Contacts

End-User Procedures
3 In the Contacts list, select the contact for whom you want to view a relationship 
hierarchy.

4 Click the Relationship Hierarchy view tab.

The Contacts Relationship Hierarchy view appears.

To define a relationship between contacts

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select the contact for whom you want to describe 
relationships; if the contact does not exist, add it. 

For more information on adding contacts, see “Adding Contacts” on page 75.

4 Click the Relationship Hierarchy view tab.

5 In the Party Relationship list, add a record and complete the necessary fields. 

Some fields are described in the following table.

The newly defined relationship is expressed in the Relationship Hierarchy 
explorer.

Field Comments

Relationship Categorizes the relationship between the contacts. Field has an LOV 
for Custom Defined Relationship values. Pre-defined values include 
Reports To, Spouse, Child, Lawyer, Board Member, Primary Contact 
(Backup), Admin Assistant, Competitor, Referral, Service Provider, 
Investor, Wealth Management Rep, Related Subsidiary, Bank 
Attorney, Trustee Attorney, and Debtor Attorney.

Type Defaults to Contact. Other values include Household, Organization, 
and Employee.

Value Select a value from a dialog box based on the Type field selection. 
For example, if Type equals Contact, then clicking the select button 
displays the Select Contact dialog box.
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Creating and Using a Book of Clients
The Book of Clients view allows end users to create, review, delete, and modify 
logical groupings of contacts. After contacts are grouped together in a book, end 
users can conduct analyses on their book as well as graphically display performance 
over a period of time. 

To create a book of clients

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select Book of Clients.

3 In the Book of Clients list, add a record and complete the necessary fields. 

Some fields are described in the following table.

4 In the lower Book of Clients list, add a record.

The Add Contact dialog box appears.

5 Select a contact to add to the current Book of Clients, and click OK.

NOTE: You can add multiple contacts at once by holding down the CTRL key and 
clicking on each record to be added. Click OK only after you have selected all of 
the records to add to the Book of Clients.

The contacts appear in the lower Book of Clients list.

To evaluate a book of clients

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select Book of Clients.

Field Comments

Book of Clients Enter a name for the book of clients.

Team Defaults to a value based on the login ID.

Comments A text description of the Book of Clients.
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3 In the Book of Clients list, select a book to evaluate.

4 In the lower Book of Clients list, select one of the Show drop-down list options 
described in the following table.

Show Comments

Book of Clients Create and view the contacts in a book of clients.

Book of Clients 
Performance

Display key metrics for assessing an entire book of 
clients’ performance.

Book of Clients Summary Displays summary information for each contact in a book 
of clients, including opportunities, financial accounts, 
service requests, alerts, affiliations, and customer value.
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A household is a group of contacts generally sharing a common link or association. 
Households provide valuable segmentation information on the household as a 
whole, as well as a summary of information about the household member contacts. 
Users can use the Households screen for identifying and capturing demographic 
information about a household. They can also use the Households screen to review 
customer’s financial accounts, products, and contact information associated with 
that household. This information allows them to assess customers’ data.

CAUTION: This chapter assumes you have renamed Siebel Account objects to 
Companies. By default, Siebel eHealthcare installs using the term Accounts. For 
more information on renaming Siebel Account objects, see the Upgrade Guide for 
your operating system.

Grouping all of a customer’s accounts by household allows a service provider to 
identify a client’s real value to the organization and seek opportunities to cross-sell 
and up-sell additional products and services to them, such as homeowners 
insurance and loans for children’s education. In addition, the ability to view all of 
a customer's financial accounts and related portfolio information by household 
allows an organization to view the household’s overall financial position. 

By following the procedures described in this chapter, users can enter, manage, and 
review information about household members (contacts), accounts, policies, 
underwriting reports, claims, opportunities, activities, service requests, and 
relationship hierarchies.

NOTE: Many of the views are read-only, as they provide a summary of information 
about household contacts. The only editable views are More Info and Contacts.
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The Households screen and associated views that appear in Siebel eHealthcare 
share much of the functionality found in Siebel eBusiness Applications. This 
chapter focuses on the household functionality that is unique to Siebel eHealthcare. 
For more information on basic household functionality, see Siebel Call Center User 
Guide.
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These scenarios are examples of workflows performed by sales representatives and 
their managers in the insurance and healthcare industries. Your company may 
follow a different workflow according to its business requirements.

Household information supports sales and service decisions for segmentation and 
cross-selling. It also provides background information for the finance and insurance 
industries about a household and all of its contacts.

A sales representative in the banking industry uses the Household screen for 
identifying and capturing demographic and relationship information about the 
household and for reviewing accounts and products associated with that 
household. From the Households screen, the sales representative creates a new 
household for a new customer. He then adds contacts to the household. 

Next, using the Relationship Hierarchy view, the sales representative reviews the 
various parties related to the household. 

Some weeks later, the sales representative wants to review household information. 
He navigates to the My Households view and then selects the Insurance Summary 
view to review a list of contacts, service requests, policies and quotes, and claims 
associated with a household.

NOTE: In the wealth management industry, a relationship manager, retail broker, or 
wealth manager has access to view the household's aggregated holdings within 
their financial accounts, the performance on these accounts, cash flows expected 
for the household for a specified period, and the household's current versus model 
portfolio allocations by sector and by asset class. For more information, see 
“Viewing and Evaluating Household Portfolios” on page 96.

In this scenario, end users are the sales representatives who manage household 
information in the field. They enter and review information to:

■ Add a household

■ Add a contact to a household

■ View household summary information
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■ View household relationships

■ View household financial account, performance, cash flow, and portfolio 
allocation details
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Households Sample Tasks
Figure 3 illustrates sample tasks that end users typically perform when managing 
households.

Figure 3. Households Sample Tasks
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The following end-user procedures are described in this section:

■ To add a household

■ To add a contact to a household on page 93

■ To view household summary information on page 94

■ To create a custom-defined relationship on page 95

■ To select a financial account associated with a household on page 97

■ To view aggregated holdings for a financial account on page 97

■ To compare account holdings against a portfolio model on page 97

■ To view the selected account holdings by sector on page 98

■ To view expected future cash flows for selected accounts on page 98

■ To view selected accounts’ past performance on page 98

Adding a Household
End users can collect and manage information about a customer’s household.

To add a household

1 Navigate to the Households screen.

2 From the Show drop-down list, select My Households.
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3 In the Households form, click the show more button, add a record, and complete 
the necessary fields.

The application automatically assigns the household an ID number in the 
Household # field.

United States law requires that financial institutions disclose their privacy 
policies regarding the sharing of non-public personal information with third 
parties and fair credit reporting that impacts the sharing of non-public personal 
information with affiliates. End users can specify a privacy level by making a 
selection from the Privacy Option field.

4 To specify a privacy level, scroll down to the Privacy Option field and select one 
of the following:

■ Opt-In. Sharing of non-public personal information is allowed without 
restrictions.

■ Opt-Out - Affiliates. Sharing of non-public personal information with affiliates 
is not allowed.

■ Opt-Out - Third Party. Sharing of non-public personal information with third 
parties is not allowed.

■ Opt-Out - All Parties. Sharing of non-public personal information with any 
affiliate or third party is not allowed.

Adding a Contact to a Household
Contacts are persons associated with a household. End users can specify one person 
in the household as the head of household and then identify the others as spouse, 
child, or dependent parent.

To add a contact to a household

1 Navigate to the Households screen.

2 From the Show drop-down list, select My Households.

3 In the Households list, select the household to which the contacts will be added.

4 Click the Contacts view tab.
Version 7.5, Rev. A Siebel eHealthcare Guide 93



Households

End-User Procedures
5 In the Contacts list, add a record.

The Add Contacts dialog box appears.

6 In the Add Contacts dialog box, you can do one of the following:

■ Select an existing contact and click OK.

■ Perform a query to choose an existing contact. 

■ Select New to add a new contact.

The contact is associated with the household.

NOTE: In the Households screen, a contact’s address is his or her residential or 
personal address. In the Contact’s screen, a contact’s address is his or her work 
address. Household addresses can only be selected from among residential 
addresses.

Viewing a Household Summary
The Household Summary view provides a comprehensive view of the household’s 
relationship with an end user’s organization in an editable format. This view 
displays basic information about the household, contacts, financial accounts, and 
past or pending service requests. 

To view household summary information

1 Navigate to the Households screen.

2 From the Show drop-down list, select My Households.

3 Click the Summary view tab.

For more information on editing summary view information, see “Configuring 
Summary Views” on page 21.
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Viewing a Household Relationship Hierarchy
End users use the Household Relationship Hierarchy view to identify and capture 
key relationships for a household. This view features a graphical tree that provides 
a visual representation of a household’s relationships. Users can create custom-
defined relationships between a household and any contact or organization. End 
users can record custom-defined relationships between any two entities in the 
adjacent Party Relationships list.

NOTE: The Relationship Hierarchy view is also available on the Contacts and 
Companies screens. For more information, see “Viewing a Contact Relationship 
Hierarchy” on page 83 and “Viewing a Company Relationship Hierarchy” on 
page 64.

To create a custom-defined relationship

1 Navigate to the Households screen.

2 From the Show drop-down list, select My Households.

3 Click the Relationship Hierarchy view tab.

4 In the Party Relationship list, add a record and complete the necessary fields. 

Some fields are described in the following table.

.

Field Comments

Relationship Categorizes the relationship between the household and the other 
entity. Field has an LOV for custom-defined Relationship values. 
Pre-defined values include Reports To, Spouse, Child, Lawyer, Board 
Member, Primary Contact (Backup), Admin Assistant, Competitor, 
Referral, Service Provider, Investor, Wealth Management Rep, 
Related Subsidiary, Bank Attorney, Trustee Attorney, and Debtor 
Attorney.
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The newly defined relationship appears in the Relationship Hierarchy explorer.

Viewing and Evaluating Household Portfolios
End users can use the Financial Accounts view tab to view a household’s portfolio 
information from a number of different perspectives:

■ Financial Accounts list. Displays financial accounts associated with contacts in 
the selected household. For more information, see “To select a financial account 
associated with a household” on page 97.

■ Aggregated Holdings List. Displays holdings within the selected accounts by asset 
class, such as securities, mutual funds, or bonds. For more information, see “To 
view aggregated holdings for a financial account” on page 97.

■ Class Allocation List. Displays a comparison of the selected account holdings 
against a portfolio model. For more information, see “To compare account 
holdings against a portfolio model” on page 97.

■ Sector Allocation List. Displays the selected account holdings by sector, enabling 
the user to view the degree of portfolio diversification. For more information, see 
“To view the selected account holdings by sector” on page 98.

■ Cash Flow List. Displays future cash flows for the selected financial accounts. 
This view allows users to estimate the amount of cash that may be available for 
future investments. For more information, see “To view expected future cash 
flows for selected accounts” on page 98.

■ Performance List. Displays how the selected accounts have performed over time. 
For more information, see “To view selected accounts’ past performance” on 
page 98.

Type Use this field to determine the type of entity with which you wish 
to establish a relationship. Defaults to Contact. Other values include 
Household, Organization, and Employee.

Value The value in this field is based on the Type field. For example, if 
Type equals Contact, then clicking the select button in Value field 
displays the Select Contact dialog box.

Field Comments
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To select a financial account associated with a household

1 Navigate to the Households screen.

2 From the Show drop-down list, select My Households.

3 In the Households list, select a household.

4 Click the Financial Accounts view tab.

5 In the Financial Accounts list, select the Aggregated Select field for the accounts 
you want to select.

NOTE: You can also click Select All to select all accounts, or click Select None to 
clear all accounts.

To view aggregated holdings for a financial account

1 Select the financial accounts. (See “To select a financial account associated with 
a household” on page 97.)

2 In the Financial Accounts list, click Generate Holdings.

The Aggregated Holdings list appears, displaying all holdings in the selected 
account by asset class, such as securities, mutual funds, or bonds. Selecting a 
specific asset class in the Aggregated Holdings displays the individual positions 
in the Holdings subview.

To compare account holdings against a portfolio model

1 Select the financial accounts. (See “To select a financial account associated with 
a household” on page 97.)

2 Click the Class Allocation subview tab.

3 In the Financial Accounts list, select a portfolio model from the drop-down list 
and click Go.

The Class Allocation list and model and actual holdings charts appear.
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To view the selected account holdings by sector

1 Select the financial accounts. (See “To select a financial account associated with 
a household” on page 97.)

2 Click the Sector Allocation subview tab.

3 In the Financial Accounts list, select a sector from the drop-down list and click 
Go.

The Sector Allocation list appears, displaying the account holdings by sector, 
enabling the user to view the degree of portfolio diversification versus the 
selected model portfolio.

To view expected future cash flows for selected accounts

1 Select the financial accounts. (See “To select a financial account associated with 
a household” on page 97.)

2 Click the Cash Flow subview tab.

3 In the Financial Accounts list, click Generate Cash Flow.

4 In the period filter, select the period for which you want to view cash flows and 
click Go.

The Cash Flow subview displays an estimate of the amount of cash that may be 
available for future investments.

To view selected accounts’ past performance

1 Select the financial accounts. (See “To select a financial account associated with 
a household” on page 97.)

2 Click the Performance subview tab.

3 In the period filter, select the period for which you wish to view an account’s 
performance and click Go.

The Cash Flow list appears, displaying how the account performed over time.
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Call reports are records of meetings and other conversations with clients, 
organizations, and individuals. Call reports are often required of employees for the 
following reasons:

■ Call reports are a means for new relationship managers to learn about the client 
and its history with the organization.

■ Call reports allow senior managers and product specialists associated with a 
certain client to keep up with the developments in the client relationship, even 
if they do not meet with the client on a regular basis.

■ Call reports provide a record of important and informal agreements. In the event 
that a failed financing transaction results in legal proceedings, these reports are 
an important component of the legal process.

Using the procedures given in this chapter, you will be able to perform the 
administrator tasks of viewing a chart of call reports and how to manage call report 
templates. End users use the Call Reports screen to add a new call report, create a 
call report distribution list, designate a report as private, and email or print call 
reports.

Siebel eHealthcare can provide notification of new call reports to designated 
individuals. For more information, see Siebel Business Process Designer 
Administration Guide for Financial Services. 
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This scenario features sample tasks performed by a sales representative at a 
healthcare company and his manager. The scenario outlined in this section is based 
on the business requirements of the healthcare industry. Your company may follow 
a different workflow according to its business requirements. 

 After returning to the office following a successful meeting with the client, a sales 
representative for the Large Group Division of a healthcare company loads 
Siebel eHealthcare to complete his call report. The representative navigates to his 
calendar and marks the meeting as Done. He then navigates to the Call Reports 
screen and enters a new call report to document the meeting. In the Report Detail 
view, he types a brief log of the meeting and adds the names of contacts and 
employees who participated.

Upon completing his report, the sales representative turns to the action items that 
resulted from the meeting. First, he needs to send an email to a fellow employee to 
tell her about the meeting. He uses the Email Report button on the Call Report form 
to accomplish this task. 

Next, he remembers that he promised to include the client on the invitation list for 
the upcoming Charity Ball, so he adds an action item on the Call Reports Action 
Items view tab. He does this by clicking Add Action Items on the Call Report form. 
After he enters his action item, along with several others, he assigns them to 
members of his team for follow-up. 

The sales representative’s boss is also a member of the client team. When she 
arrives in the office the next day and loads Siebel eHealthcare, she reviews the new 
call reports on the Call Reports screen, reading about the meeting details and notes. 

In this scenario, managers or Siebel administrators can view graphical 
representations of their call reports call, volume analysis of their own calls, their 
team’s calls, or all call reports in Siebel eHealthcare.

The end users are sales representatives who create call reports to record their 
meetings and activities. They enter information to:

■ Create new call reports 

■ Create call report distribution lists
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■ Create call report action items

■ Attach related documents

■ Specify a call report as private

■ Review and add additional notes or comments

■ Email or print call reports
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Call Reports Sample Tasks
Figure 4 illustrates sample tasks that administrators and end users typically perform 
when managing call reports.

Figure 4. Call Reports Sample Tasks
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The following administrator procedures are described in this section:

■ To view a chart for your call reports

■ To activate the Auto Call Report Workflow on page 104

Viewing Call Report Charts
As a manager or Siebel administrator, you can use the Call Report Charts view for 
call volume analysis of your own calls, your team’s calls, or all call reports in 
Siebel eHealthcare. Using this view, you can analyze call volume and call types by 
employee and by customer to determine which clients are receiving the most 
service.

To view a chart for your call reports

1 Navigate to the Call Reports screen.

2 From the Show drop-down list, select one of the following:

■ My Call Reports

■ My Team’s Call Reports

■ All Call Reports

The view selected returns an appropriate set of call report records to be 
analyzed.

3 Click the Charts view tab.

The chart reflects only those call report records which are currently selected; 
that is, those records listed in the Call Reports list above the chart.
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4 From the lower Show drop-down list, select one of the following chart types:

NOTE: Place your cursor over any chart segment to reveal additional information 
about that segment. Click a segment to drill down and refocus on just the call 
reports in that segment.

Activating the Auto Call Report Workflow
When activated, the Auto Call Report Workflow allows end users to create call 
report records automatically from the Contacts, Companies, Activities, and Call 
Reports screens. After the administrator activates the Auto Call Report Workflow, 
end users will see the Auto Call Report icon in the upper left corner of those screens.

To activate the Auto Call Report Workflow

1 From the application-level menu, choose View > Site Map > Business Process 
Administration> Workflow Processes.

2 In the Workflow Processes list, select the New Call Report Workflow record.

3 Click the Activate button at the top of the list to activate this workflow process.

4 Reload personalization rules in Runtime Event Administration. For more 
information, see Personalization Administration Guide. 

Chart Comments

Call Type Analysis A breakdown of all selected call reports by Call Type.

Call Volume Analysis Charts the number of calls per month, quarter, or year.

Call Volume by 
Employee

Charts the number of calls per month, quarter, or year, per 
employee.

Company Calling 
Analysis

Charts the number of calls per company.

Employee Calling 
Analysis

Charts the number of calls per company, by employee.
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To use the Auto Call Report feature once activated, end users can either click the 
icon, can choose File > Auto > Call Report from the application-level menu, or can 
use the short cut key Alt+P.

NOTE: The Auto Call Report Workflow uses the Data Transfer Utility business service 
to transfer fields from one view to another. To modify the Auto Call Report 
Workflow so that it is available from more screens or to populate more fields when 
moving from one screen to the next, see the Data Transfer Utility section in Siebel 
Business Process Designer Administration Guide. The current Data Map Objects 
used for the Auto Call Report in the Data Transfer Utility business service include: 
Auto Call Report - Account, Auto Call Report - Activity, Auto Call Report - Contact, 
and Auto Call Report - Opportunity. 
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The following end-user procedures are described in this section:

■ To add a call report

■ To create a distribution list on page 108

■ To associate action items, notes, and attachments on page 109

■ To set a privacy flag on page 109

■ To email or print a call report on page 110

Managing Call Reports
Managing Call Reports entails adding, modifying, and deleting call reports. After a 
call report is added, end users can associate it with action items, notes, and 
attachments.

NOTE: Call report attachments, like the attachments for other activities, are stored in 
the S_ACTIVITY_ATT table. 

To add a call report

1 Navigate to the Call Reports screen.

2 From the Show drop-down list, select My Call Reports.
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3 In the More Info form, add a record and complete the necessary fields. 

Some fields are described in the following table.

NOTE: In the Call Reports list, the New flag is a calculated field and appears 
checked for five days after the creation of a call report. Your systems 
administrator can change this setting. 

Field Comments

Associated Activity The activity that is the subject of the call report; each call 
report can have only one associated activity. Selection of the 
associated activity is governed by the following constraints if 
those fields are populated:

■ Same Company ID

■ Same Primary Opportunity ID

■ Same Primary Contact ID

Contacts Enter the participating contacts who were at the meeting. 
Designate a primary contact if desired, otherwise the first 
contact selected will be defaulted as the primary. Entries 
appear in the Report Detail view and on the printed Call 
Report.

Description A summary description of the call report; enter a more 
detailed report in the Report Detail view.

Distribution List additional employees from your organization who should 
receive the Call Report, but should not appear on the list of 
participants. The call report creator and all Employee 
Participants are automatically placed on the distribution list.

Employees List employees from your organization who participated in 
the call. Entries appear in the Report Detail view and on the 
printed Call Report. The call report creator is automatically 
listed as a participant.

Opportunity Associate an opportunity with the call report. You can view all 
call reports associated with any given opportunity from the 
Opportunities screen.

Type The LOV type for this field is 
FINCORP_CALLRPT_CONTACT_TYPE.
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4 In the Call Reports list, drill down on the Description hyperlink to navigate to 
the Report Detail view.

The Call Report form appears.

5 In the Call Report form, enter detailed information about the call. Information 
you enter here appears in emailed or printed call reports.

Creating a Distribution List
A distribution list is the list of contacts who need to know what is happening with 
a particular client. Usually, it is the coverage team for the client, plus any additional 
employee participants. The application automatically places the call report creator 
and each employee participant on the distribution list. For other employees, such 
as the coverage team, to receive a call report, end users must manually add them 
to the distribution list.

When end users use the call report Email Report feature, the distribution list 
controls who receives the report. The call report Print Report function and the Send 
Email function, both available through the application-level File menu (F9), are not 
affected by the distribution list.

To create a distribution list

1 Navigate to the Call Reports screen.

2 From the Show drop-down list, select My Call Reports.

3 In the Call Reports list, select the call report for which you want to create a 
distribution list.

4 In the Distribution field, click the select button.

5 In the Employees dialog box, click New.

6 In the Add Positions dialog box, select one or more employees to add to the 
distribution list and click OK.

The Employees dialog box reappears with the selected name or names added to 
the distribution list.

7 Click OK.
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Associating Action Items, Notes, and Attachments
After an end user has added a call report, they can associate it with action items, 
notes, and attachments.

To associate action items, notes, and attachments

1 Navigate to the Call Reports screen.

2 From the Show drop-down list, select My Call Reports.

3 In the Call Reports list, select a call report.

4 Click the Report Detail view tab.

5 In the Employee Participants and Contact Participants lists, add a new record as 
appropriate to capture report detail information.

6 To add notes or action items to the call report, click the appropriate button in 
the Call Report form:

■ Add Notes. To add notes or comments.

■ Add Action Items. To add an action item.

7 To attach external documents to a call report, click the Attachments view tab.

8 In the appropriate list, add a record and complete the necessary fields.

Setting the Privacy Flag
Certain call reports may contain highly sensitive or confidential information about 
a given company or opportunity. Users can designate certain calls as private by 
clicking the Private check box in the form or list of the call report. After a call report 
is marked private, only those on the distribution list have access to it. For more 
information on the distribution list, see “Creating a Distribution List” on page 108.

To set a privacy flag

1 Navigate to the Call Reports screen.

2 From the Show drop-down list, select My Call Reports.
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3 In the Call Reports list, select the call report that you want to mark as private 
and click the Private field.

The call report is now categorized as private. Only the employees on the 
distribution list can access it.

Emailing and Printing a Call Report
Call reports can be emailed or printed for distribution and record keeping. 

To email or print a call report

1 Navigate to the Call Reports screen.

2 From the Show drop-down list, select My Call Reports.

3 In the Call Reports list, select the call report that you want to email or print.

4 Click the Report Detail view tab.

5 In the Call Report form, do one of the following:

■ To email the report, click Email Report.

The report is automatically emailed to everyone on the distribution list.

■ To print the report, click Print Report. 

In the Reports dialog box, select Summary or Detail and click Run.
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Facilities are healthcare organizations that are paid by or file claims with your health 
plan or health insurance company. Examples of facilities are hospitals, clinics, and 
pharmacies. Facilities are also referred to as provider organizations.

Using the procedures given in this chapter, you will be able to perform the 
administrator tasks of adding facilities to Facility Locator. End users use the 
Facilities screens to associate providers, facilities, and contacts with a facility, add 
a facility contract, add a facility payment, and add a facility claim.
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This scenario features sample tasks performed by a contracting specialist. Your 
company may follow a different workflow according to its business requirements.

In this scenario, a contracting specialist for a health plan is responsible for 
managing information about the healthcare facilities, such as hospitals and 
healthcare networks, with which your company does business. She just established 
a contract with a single facility.

She adds the new facility to the Siebel database. Next, she adds information about 
the facility’s business hours and specialties. Then, she associates the facility with 
individual providers and with other facilities. Next, she adds information about 
contracts the facility holds with your company along with the facility’s payment 
preferences.

In this scenario, the end users are contracting specialists for a health plan. They 
enter information to:

■ Add new facilities

■ Associate providers, facilities, and contacts with a facility

■ Add facility contracts, facility payments, or facility claims
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Figure 5 illustrates sample tasks that administrators and end users typically perform 
when managing facilities.

Figure 5. Facilities Sample Tasks
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The following administrator procedure is described in this section:

■ To add a facility to the facility locator

Adding Facilities to the Facility Locator
As an administrator, you can add facilities to the facility locator. The facility locator 
searches for facilities using latitude and longitude. If you do not know the latitude 
and longitude, leave those fields blank. If the City, State, Zip Code, and Country 
fields are correct, the latitude and longitude values will automatically generate 
when you save the facility. 

NOTE: The latitude and longitude values will not generate if any one value in the 
City, State, Zip Code, or Country fields is incorrect. For example, if the ZIP Code is 
incorrect, you will receive an error message. To correct this problem, navigate to the 
Application Administration, ZIP Code Administration view and make sure the Geo 
values for that city, state, and ZIP Code combination has been loaded. For more 
information, see Siebel eService Administration Guide.

To add a facility to the facility locator

1 From the application-level menu, choose Site Map > Application Administration 
> Branch/Facility Locator Administration.

2 In the Branch/Facility Locations list, add a record.

3 In the Branch/Facility Locations list, complete the necessary fields.
114 Siebel eHealthcare Guide Version 7.5, Rev. A



Facilities

End-User Procedures
End-User Procedures
The following end-user procedures are described in this section:

■ To add a facility

■ To associate a provider, facility, or contact with a facility on page 116

■ To add a facility contract on page 117

■ To add a facility payment on page 117

■ To add a facility claim on page 118

Adding Facilities
End users can add or change healthcare facility records. After users add facility 
records in the Facilities screen, they can view them in both the Facilities screen and 
the Companies screen. In the Companies screen, a check mark appears in the 
Facility field of the record, indicating that the company is a facility.

NOTE: If users add healthcare facility records in the Companies screen, they will not 
appear in the Facilities screen.

To add a facility

1 Navigate to the Facilities screen. 

2 In the Facilities list, add a record and complete the necessary fields.

NOTE: Records in the Facilities list contain a few of the most frequently used 
facility fields. You can add text into additional fields, such as Main Office, in the 
More Info form.
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Associating Providers, Facilities, and Contacts with a Facility
Facilities usually have affiliations with providers, other facilities, or contacts. For 
example, a hospital may be affiliated with a clinic.

To associate a provider, facility, or contact with a facility

1 Navigate to the Facilities screen. 

2 In the Facilities list, select the facility with which you want to associate a 
provider, facility, or contact.

3 Click the appropriate view tab:

■ Summary. To associate a contact with a facility, use the Contacts list on this 
view tab.

■ Affiliated Providers. To associate a provider with a facility.

■ Facility Affiliations. To associate a facility with another facility.

4 If the provider, facility, or contact you want to choose is in the selected list, select 
the record and click OK.

5 If the record does not appear in the list:

a In the selected list, click New.

b In the dialog box, add a record and complete the fields or select an existing 
record.

Adding Facility Contracts
A company may have contracts with a facility or provider organization, in addition 
to contracts with individual providers. For example, they may have a contract with 
a pharmacy or clinic. Each contract may have different terms, payment preferences, 
and payment methods.

End users can set up payment preferences and payment methods for facilities. Their 
company may have more than one contract with a facility. They can set up different 
payment arrangements and methods for each contract.
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To add a facility contract

1 Navigate to the Facilities screen. 

2 In the Facilities list, select a facility. 

3 Click the Contracts view tab.

4 In the Contracts list, add a record and complete the necessary fields.

5 If payments will be made by EFT or check, scroll down to the Payment 
Preferences - Check form and select one of the following from the drop-down 
list:

■ Payment Preferences - Check. To add information for check payments.

■ Payment Preferences - EFT. To add information for electronic funds transfer 
payments.

6 Complete the necessary fields.

Adding Facility Payments
End users can add information about payments their company makes to facilities. 
Payment information can include payment amount, payment date, payment 
adjustments, and reason for payment.

Facility payments may be imported from a bill payment engine by using Siebel 
eBusiness Application Integration. For more information, see “Integration” on 
page 191 and Overview: Siebel eBusiness Application Integration Volume I.

To add a facility payment

1 Navigate to the Facilities screen. 

2 In the Facilities list, select a facility.

3 Click the Payments view tab.
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4 In the Payment list, add a record and complete the necessary fields.

NOTE: Records in the Payments list contain a few of the most frequently used 
payment fields. To add text into additional fields, such as Check #, scroll down 
to the Payment Details form.

Adding Facility Claims
A contract with a facility may specify that the facility should be paid each time it 
provides a service to a member. If so, the facility or member may contact a company 
to initiate claims for payment.

Facility claims may be imported from a claims processing engine, by using Siebel 
eBusiness Application Integration. For more information, see “Integration” on 
page 191 and Overview: Siebel eBusiness Application Integration Volume I.

To add a facility claim

1 Navigate to the Facilities screen. 

2 In the Facilities list, select a facility.

3 Click the Claims view tab.

4 In the Claims list, add a record.

5 In the Add Claims dialog box, perform the appropriate task:

■ To choose an existing record, select a record and click OK.

■ To add a new record, click New and complete the fields.

NOTE: Records in the Claims list contain a few of the most frequently used claims 
fields. To add text into additional fields, scroll down to the Claims form.
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Individual health policies are insurance policies issued to individuals for themselves 
and their family members or dependents. Each individual health policy includes 
one primary member and may include additional members.

Each individual health policy offers one or more products, called policy coverages. 
Examples of individual health insurance products are HMO, PPO, dental, and vision 
coverage.

The Individual Health Policies screen allows end users to manage individual health 
insurance policies. Using the procedures given in this chapter, end users can 
generate quotes, accept applications, handling service requests, and process claims.

NOTE: In order to generate quotes from the Individual Health Policies screen, you 
must purchase the Siebel Proposals & Presentations module.

For more information on views common to all policy screens, see “Common Policy 
Views” on page 132.
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This scenario features sample tasks performed by a licensed sales representative. 
Your company may follow a different workflow according to its business 
requirements.

In this scenario, a licensed sales representative for an insurance company is on the 
phone with a prospective customer who has called to request a quote for individual 
health insurance.

The sales representative adds information about the prospect and the prospect’s 
dependents (including coordination of benefits). The prospect requests a quote for 
PPO coverage, dental insurance, and vision insurance. The sales representative adds 
the products and reviews the product attributes. Next, he asks the prospect for 
enough information to provide an initial premium quote to the prospect. He gives 
the prospect a verbal quote and ends the conversation. 

One week later, he receives an email message that the prospect has called back and 
would like to purchase a policy. In Siebel eHealthcare, he adds information about 
coverages for each applicant according to the needs of the prospect. In this case, 
one of the dependents will receive both dental and vision coverage. Another will 
receive vision coverage only. Therefore, he associates the first dependent with both 
vision and dental, and the second dependent with vision only. Next, he schedules 
an activity as a reminder to call the prospect back with the revised premium 
information.

During the second call, he gathers information from the prospect in order to process 
the application. First, he performs a health risk assessment for each applicant. Then 
he adds billing and payment arrangements. Finally, he follows the procedures 
implemented by his company to submit the policy for issuance and billing.

In this scenario, end users are a sales representatives who manages customer 
requests. They enter information to:

■ Generate customer quotes

■ Add an applicant

■ Perform a health risk assessment

■ Convert a quote to an active policy
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■ Associate a policy coverage with an applicant

■ Add a service request

■ Set up a payment plan

■ Add detailed payment information for a payment plan
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Individual Health Policies Sample Tasks
This section details sample tasks often performed by administrators and end-users 
when managing individual health policies. Your company may follow a different 
workflow according to its business requirements. 

Administrator Procedures
The following list shows tasks administrators typically perform to manage 
individual health policies.

■ Define products and specify product line types. For more information, see “Adding 
Products and Product Lines” on page 123.

■ Add rate band information such as deductibles, premiums, and payroll deductions for 
each insurance product. For more information, see “Adding Rate Bands” on 
page 124.

End-User Procedures
The following list shows tasks end users typically perform when managing 
individual health policies.

■ Provide quotes. For more information, see “Providing Quotes” on page 125.

■ Accept applications by adding applicants, performing health risk assessments, and 
associating policy coverages with each applicant. For more information, see 
“Accepting Applications” on page 127.

■ Add service requests. For more information, see “Adding Service Requests” on 
page 129.

■ Set up payment plans. For more information, see “Setting Up Pay Plans” on 
page 130.
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The following administrator procedures are described in this section:

■ To add an insurance product

■ To specify product line type on page 123

■ To add a rate band on page 124

NOTE: Only those with Siebel administrator responsibilities can change entries in 
the Insurance Administration and Product Administration screens.

Adding Products and Product Lines
As an administrator, you can add products to the Siebel database. This section 
describes the procedure for setting up products and product lines in general terms. 

You can also specify that a product line is one that your company contracts agencies 
to sell, or that the state licenses agencies to sell, or both.

To add an insurance product

1 Set up the product class structure, including product class attributes.

For more information about adding product classes, see Applications 
Administration Guide. 

2 Add the products to the Siebel database and associate them with the appropriate 
class. 

3 In the Category field in the Products list, select Individual Health Insurance.

4 Include the product in a product line.

To specify product line type

1 From the application-level menu, choose View > Site Map > Application 
Administration > Product Lines.

2 In the Product Line list, select one or both of the following fields:
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■ Contracting. To specify that the product line is one that your company 
contracts agencies to sell.

This product line will appear to end-users as a choice in the Lines of Business 
dialog box in the Partners screen > Contracts view tab.

■ Licensing. To specify that the product line is one that agencies can be granted 
a state license to sell.

This product line will appear to end-users as a choice in the Lines of Business 
dialog box in the Partners screen > Licenses & Appointments view tab.

A check box appears in the middle of the field.

3 To specify a product line as contracted or licensed, click the appropriate column.

For more information about adding products and product lines, see Product 
Administration Guide. 

Adding Rate Bands
After you add a product in the Product Administration screen, you can use the 
Insurance Administration screen to associate a rate band with the product. A rate 
band is pricing information about the deductible, the premium, and the payroll 
deduction for each insurance product. 

To add a rate band

1 From the application-level menu, choose View > Site Map > Insurance 
Administration > Health and Group Products.

2 In the Products list, select a product.

3 In the Rate Bands list, add a record and complete the necessary fields.
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The following end-user procedures are described in this section:

■ To provide a quote

■ To add an applicant on page 127

■ To perform a health risk assessment on page 128

■ To convert a quote to an active policy on page 128

■ To associate policy coverages with an applicant on page 129

■ To add a service request on page 129

■ To set up a pay plan for an individual health policy on page 130

■ To add detailed billing information for a pay plan on page 130

Providing Quotes
In Siebel eHealthcare, a quote is a policy that has not been issued. End users can 
provide a quote for a new policy or make changes to an existing quote. The 
following procedure shows how to provide a quote for a new policy. The Individual 
Health Policies screen captures the information necessary to generate a quote. If a 
plan has predefined rates for individuals, Siebel eHealthcare can access this 
information in two ways:

■ Using Siebel Pricer. For information, see Pricing Administration Guide.

■ Using an external table that your company has integrated with Siebel 
eHealthcare.

To provide a quote

1 Navigate to the Individual Health Policies screen.

2 In the Individual Health Policies list, add a record and complete the necessary 
fields.

3 To add a new applicant:

a Click the Applicants view tab.
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b Scroll down to the Applicants form and add a record.

c In the Add Applicants dialog box, select an existing applicant or click New to 
add a new applicant.

If you select an existing contact who is not a member, the Coordination of 
Benefits field will not be hyperlinked to the Members > Applicants view.

d Repeat Step 3 for each new applicant that you want to add to this quote.

4 To select an existing contact:

a Click the Applicants view tab.

b Scroll down to the Applicants form and click the Show More button.

c In the Applicants form, add a record.

d In the Add Applicants dialog box, select a record and click OK.

NOTE: If you select an existing contact who is not a member, the Coordination 
of Benefits field will not be hyperlinked to the Members > Applicants view.

e To specify a contact as a member, select the Members check box.

After you save the record, the Coordination of Benefits value is hyperlinked 
to the Members > Applicants view.

f If you plan to add records to the Coordination of Benefits field, select the 
Coordination of Benefits check box.

After you save the record, the Coordination of Benefits field changes to Yes.

g Repeat Step 4 for each existing contact that you want to add to this quote.

NOTE: For information about Coordination of Benefits, see “Adding a 
Member's Additional Benefits Coverage” on page 156.
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5 In the Applicants list, select the record for the primary applicant for this quote 
and click the Primary field.

A check mark appears, indicating that this applicant is the primary applicant.

NOTE: If you do not select the primary field for one of the applicants, you will 
not be able to successfully add a product in the Policy Coverages view.

6 Click the Policy Coverages view tab.

7 In the Policy Coverages product list, add a record and complete the necessary 
fields.

8 Repeat Step 6 and Step 7 for each product you would like to add for this 
applicant.

After end users generate the quote, the Primary field is automatically added. The 
quote for this applicant appears in the Premium Totals field in the Policy Coverages 
list.

Accepting Applications
Accepting applications requires adding applicants, performing health risk 
assessments for each applicant, and associating policy coverages with each 
applicant. If end users have already provided a quote for an application, they can 
begin by performing a health risk assessment for each applicant listed in the quote.

To add an applicant

1 Navigate to the Individual Health Policies screen.

2 Click the Applicants view tab.

3 In the Applicants list, add a record.

4 In the Add Applicants dialog box, perform the appropriate task:

■ To choose an existing record, select a record and click OK.
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■ To add a new record, click New and complete the fields.

NOTE: The Primary field is filled automatically after you generate a quote.

5 Repeat Step 3 and Step 4 for each applicant you would like to add.

6 In the Applicants list, select the record for the primary applicant for this quote 
and click the Primary field.

A check box appears in the Primary field.

7 If the check box is empty, select it.

A check mark appears, indicating that the selected applicant is the primary 
applicant.

After end users add an applicant, they need to perform a health risk assessment for 
each one.

To perform a health risk assessment

1 Navigate to the Individual Health Policies screen.

2 In the Individual Health Policies list, select a record.

3 Click the Health Risk Assessments view tab.

The Health Risk Assessments form appears, showing the selected record. 

4 Scroll down to the Risk Assessment form, add a record, and complete the 
necessary fields

5 Repeat Step 4 for each applicant.

After end users complete the risk assessment, they can convert the quote to an 
active policy.

To convert a quote to an active policy

1 Navigate to the Individual Health Policies screen.

2 In the Individual Health Policies list, select a record.
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3 Click the Applicants view tab and scroll up to the Individual Health Policies 
form.

4 In the Individual Health Policies, More Info form, change the following fields:

a In the Status field, select Inforce.

b In the Effective Date field, add the date that the policy will go into effect.

After end users convert the quote to an active policy, they can associate policy 
coverages with an applicant.

To associate policy coverages with an applicant

1 Navigate to the Individual Health Policies screen.

2 Select the record in the Individual Health Policies list for which you would like 
to set up policy coverages.

3 Click the Member Coverages view tab.

4 In the Member Coverages product list, add a record, and complete the necessary 
fields.

5 Repeat Step 4 for each additional applicant.

NOTE: You can also use the Member Coverage Matrix view to select applicant and 
dependent coverages. However, the Member Coverage view should be used to 
associate a primary care provider. For additional information, see “Changing a 
PCP or a Primary Network or IPA for Members” on page 155.

Adding Service Requests
End users can add service requests for individual health policies. Examples of 
service requests are a change of primary care provider, a request for literature, or a 
question about an insurance claim.

To add a service request

1 Navigate to the Individual Health Policies screen.

2 In the Individual Health Policies list, select a policy.
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3 Click the Service Requests view tab.

4 In the Service Requests list, add a record and complete the necessary fields.

Setting Up Pay Plans
End users can use the Pay Plans view tab to set up pay plans for individual health 
insurance policies and to add details about payment methods and due dates.

To set up a pay plan for an individual health policy

1 Navigate to the Individual Health Policies screen.

2 In the Individual Health Policies list, select a policy, and click the Bill To view 
tab.

3 In the Pay Plan list, add a record and complete the necessary fields.

4 Scroll down to the Bill To Address form.

5 In the Bill To Address form, in the Last Name field, click the select button.

6 In the Pick Contact dialog box, select a contact and click OK.

After end users complete the Bill To Address form, they can add pay plan 
information.

To add detailed billing information for a pay plan

1 Click the Pay Plans view tab.

2 In the Pay Plans list, add a record and complete the necessary fields.
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Group policies are insurance policies sold to a group on behalf of its members. The 
group is the insured party and can be an employer purchasing insurance for its 
employees, a group of employers who are purchasing insurance together, or an 
association or club purchasing insurance for its members.

Each group policy can offer many products. Group insurance products include 
group life, supplemental group life, group disability, group health, vision, and 
dental.

Some group policies, especially those for larger groups, offer different products to 
different employee classes of group members. Examples of employee classes are 
salaried employees and hourly employees.

Group members have the option to accept coverage that is available for their class. 
Group members who accept coverage are enrolled in the policy and are considered 
the primary member of the policy. Enrolled members are usually referred to as 
members (for health insurance) or policyholders (for other kinds of insurance).

Primary members can choose products for themselves and for family members or 
dependents. Usually, different products are available for primary members and for 
other policy members.

The Group Policies screen allows users to manage group insurance. Specifically, it 
allows end users to generate proposals, create policies and quotes, add employee 
classes, design plans, enroll members, and provide service for the policy.

NOTE: In order to generate proposals from the Group Policies screen, you must 
purchase the Siebel Proposals & Presentations module.
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Table 4 describes views common to all policy screens.

For more information on other healthcare policy views, see “Individual Health 
Policies” on page 119.

Table 4. Common Policy Screen Views

View Tab Description

Summary Displays a summary of key data associated with a policy in a single 
view.

Claims Displays claims recorded for an individual policy. 

Proposals Allows for the creation and retrieval of quotes prepared for a customer 
associated with an individual quote or policy. Proposals would 
normally show up in the quote process, but not later.

Underwriting 
Reports

Allows users to collect and manage underwriting information 
associated with an application. These reports are sometimes ordered 
during the application process and sometimes after an application is 
submitted.

Documents Allows users to collect and manage documents associated with an 
application.
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This scenario features sample tasks performed by a licensed sales representative. 
Your company may follow a different workflow according to its business 
requirements.

In this scenario, a licensed sales representative for an insurance company is on the 
phone with an insurance agent. The insurance agent has called on behalf of a 
prospective customer who wants to offer insurance to its employees at group rates.

In Siebel eHealthcare, the sales representative adds a policy record for the company, 
which automatically assigns a unique policy number to the company. Then he adds 
census information for the company, sets up employee classes, and adds a plan 
design by adding (or configuring) products for the policy. The plan design 
information and census data can be sent to the insurance company’s rating engine 
to generate a quote for this policy.

Next, he uses a template to generate a proposal, which he then sends to the 
prospect.

Two weeks later, he receives an email message from the agent indicating that the 
prospect has called back and will probably purchase a policy, but requires a revised 
proposal. He selects a static group insurance plan (or creates a dynamic group 
insurance plan using Siebel eConfigurator) according to the needs of the prospect. 
Next, he schedules an activity as a reminder to return the call with the revised 
premium information.

The prospect accepts the revised proposal. Now the sales representative needs to 
complete the procedures necessary to issue a policy. This includes collecting 
information about group members and about billing and payment preferences. He 
follows the procedures implemented by his company to submit the policy for 
issuance and billing.
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Group Policies Sample Tasks
This section details sample tasks often performed by administrators and end users 
when managing group policy information. Your company may follow a different 
workflow according to its business requirements. 

Administrator Procedures
The following list shows procedures administrators typically perform to administer 
group policy information.

■ Add products, product lines, and coverage options. For more information, see 
“Adding Products and Product Lines” on page 136.

■ Add rate bands. For more information, see “Adding Rate Bands” on page 137.

■ Define activity plan templates. For more information, see “Defining Activity Plan 
Templates” on page 138.

End-User Procedures
The following list shows tasks end users typically perform when managing group 
insurance policy information.

■ Add a policy record. For more information, see “Adding Policy Records” on 
page 139.

■ Add census information and associate a census with a policy. For more information, 
see “Adding Census Information in the Group Policies Screen” on page 140 and 
“Associating a Census with a Policy” on page 141.

■ Add an employee class. For more information, see “Adding Employee Classes” on 
page 142.

■ Create a plan design and reconfigure customization products in a plan design. For 
more information, see “Designing Plans for Group Policies” on page 142 and 
“Reconfiguring Customizable Products in Plan Design” on page 146.

■ Create a proposal. For more information, see “Generating Proposals” on 
page 146.
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■ Collect and manage underwriting information. For more information, see “Managing 
Underwriting Information” on page 147.

■ Add an eligible member. For more information, see “Adding Eligible Members” on 
page 148.

■ Enroll a member. For more information, see “Enrolling Members” on page 148.

■ Add a beneficiary. For more information, see “Adding Beneficiaries” on page 150.

■ Set up a payment plan. For more information, see “Setting Up Payment Plans” on 
page 150.
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The following administrator procedures are described in this section:

■ To add a group insurance product

■ To add a rate band on page 137

■ To create an activity plan template on page 138

■ To create activities for the template on page 138

NOTE: Only those with Siebel administrator responsibilities can change entries in 
the Insurance Administration and Product Administration screens.

Adding Products and Product Lines
As an administrator, you can add products to the Siebel database. This section 
describes the procedure for setting up products and product lines in general terms. 

You can also specify that a product line is one that your company contracts agencies 
to sell, or that the state licenses agencies to sell, or both.

To add a group insurance product

1 Set up the product class structure, including product class attributes.

For more information about adding product classes, see Siebel Applications 
Administration Guide. 

2 Add the products in the Product Administration screen and associate them with 
the appropriate class. 

3 In the Category field in the Products form, select Group Insurance.

4 Include the product in a product line.
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5 Specify a product line type:

a From the application-level menu, choose View > Site Map > Application 
Administration > Product Lines.

b In the Product Line list, select one or both of the following fields:

❏ Contracting. To specify that the product line is one that your company 
contracts agencies to sell. This product line will appear to end users as a 
choice in the Lines of Business dialog box in the Partners, Contracts view 
tab.

❏ Licensing. To specify that the product line is one that agencies can be 
granted a state license to sell. This product line will appear to end users 
as a choice in the Lines of Business dialog box in the Partners, Licenses & 
Appointments view tab.

A check box appears in the middle of the field.

c Click in a blank check box to select the product line type or click the X in a 
check box to clear it.

For more information about adding products and product lines, see Product 
Administration Guide. 

6 Set up the Customization Product by defining configuration rules and specifying 
the user interface. 

For more information, see the section on creating customizable products in 
Product Administration Guide.

Adding Rate Bands
After you add a product in the Product Administration screen, you can use the 
Insurance Administration screen to associate a rate band with a product. A rate 
band is pricing information about the deductible, the premium, and the payroll 
deduction for each insurance product.

To add a rate band

1 From the application-level menu, choose View > Site Map > Insurance 
Administration > Health and Group Products.
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2 In the Products list, select a product.

3 In the Rate Bands list, add a record and complete the necessary fields.

Defining Activity Plan Templates
Activity Plan Templates allow you to create and manage activities related to group 
policies. You define templates using the Application Administration screen Activity 
Templates and Activity Template Details views. 

To create an activity plan template 

1 From the application-level menu, choose View > Site Map > Application 
Administration > Activity Templates.

2 In the Activity Plan Templates list, add a record. 

3 In the Name field, type a name for the template.

4 In the Type field, choose FINS Group Policy.

5 Complete the remaining necessary fields.

For more information, see Siebel Applications Administration Guide.

To create activities for the template 

1 From the application-level menu, choose View > Site Map > Application 
Administration > Activity Templates.

2 In the Activity Plan Templates list, select a template.

3 Click the Activity Template Details view tab. 

4 In the Activity Template Details list, add a record.

5 Complete the necessary fields for each activity assigned to the template.

6 From the drop-down list, choose an activity type.

NOTE: Repeat Step 2 through Step 6 to add activities to the template. 

7 Save the activity.
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The following end-user procedures are described in this section:

■ To add a policy record on page 139

■ To add census information on page 140

■ To associate a census with a policy on page 141

■ To add an employee class on page 142

■ To add a plan design on page 143

■ To dynamically reconfigure customizable products in plan design on page 146

■ To generate a proposal on page 146

■ To add underwriting information on page 147

■ To view historical underwriting information on page 147

■ To add an eligible member on page 148

■ To enroll a member on page 149

■ To add a beneficiary on page 150

■ To set up a payment plan for a group policy on page 150

Adding Policy Records
Adding a group policy record is the first step in generating a policy proposal or 
issuing a group policy. After end users add a policy record, they must set up 
employee classes, add a policy plan design, and generate a policy proposal. If the 
customer accepts the proposal, they add eligible members, enroll members who 
elect coverage under the plan, and set up policy payment plans. 

To add a policy record

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, add a record and complete the necessary fields.
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Adding Census Information in the Group Policies Screen
End users can add census information for companies that request a quote or 
proposal for a group insurance policy. To add census information, end users must:

■ Add a policy in the Group Policies screen

■ Add census information using the instructions in the “To add census 
information” procedure

■ Associate the census with the policy

NOTE: After users add the census information, they can associate the census with 
the policy. For more information, see “Associating a Census with a Policy” on 
page 141.

To add census information 

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a policy.

3 Click the Census view tab.

4 In the Census list, from the Show drop-down list, select Segmented Census or 
Detailed Census.

■ Segmented Census. Allows you to add information for groups of employees.

■ Detailed Census. Allows you to add information for individual employees.

NOTE: Usually, you will add detailed or segmented information for a single 
census. However, you can add information for both.

5 In the Census list, add a record and complete the necessary fields.

6 If you selected Segmented Census:

■ Scroll down to the Employee Count list.

■ In the Employee Count list, add a record and complete the necessary fields.
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7 If you selected Detailed Census: 

■ Scroll down to the Employee List list.

■ In the Employee List list, add a record and complete the necessary fields.

To add attachments associated with a group policy

1 Navigate to the Group Policies screen.

2 Click the Attachments view tab.

3 In the Attachments list, add a record.

4 In the Attachment Name field, click the select button.

5 In the Add Attachment dialog box, do one of the following:

■ Click Browse, and select the file to be added as an attachment.

■ In the URL field, type a URL to the file to be added as an attachment.

6 Click Add.

Associating a Census with a Policy
After end users add the census information, they can associate the census with the 
policy.

To associate a census with a policy

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a policy.

3 In the Policy Census field of the Policies/Quotes form, click the select button.

NOTE: If this field does not display, click the menu button and choose Columns 
Displayed. After you move Policy Census to the Selected Columns list and click 
Save, the Policy Census field will appear.

The Pick Group Census dialog box appears, showing each census available for 
that policy.
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4 In the Pick Group Census dialog box, select a census and click OK.

Adding Employee Classes
Some group policies, especially those for larger groups, offer different products to 
different employee classes of group members. Examples of employee classes are 
salaried employees and hourly employees. Each employee class offers a unique 
combination of products, product options, and product rates. Users can use the 
Classes view to add or make changes to employee classes.

To add an employee class

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a policy.

3 Click the Classes view tab.

4 In the Classes list, add a record and complete the necessary fields.

Designing Plans for Group Policies
End users can design plans for group polices by adding information about products, 
product classes, and rate bands. A rate band is pricing information about the 
deductible, the premium, and the payroll deduction for each insurance product. The 
following lists are available in the Plan Design view:

■ Product Attributes. This view contains the Plan Design Product list and the 
Attributes list. Use the Plan Design Product list to associate a product with the 
policy that appears in the Group Policy form. Use the Attributes list to view 
attribute information and change attribute values.

■ Product Classes. This view contains the Plan Design Product list and the Classes 
list. Use the Classes list to select employee classes that you want to associate 
with the selected product.

■ Product Class Matrix. This view contains the Plan Design Product Class Matrix 
list. In this list, you associate an employee class with the selected product.

■ Product Class Rate Bands. This view contains the Plan Design Product Class Rate 
Band list. Use this list to associate a rate band with the selected product/class.
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To add a plan design

1 From the application-level menu, choose View > Site Map > Group Policies > 
My Policies/Quotes.

2 In the Policies/Quotes list, select a group policy and click the Plan Design view 
tab.

The Plan Design Products list appears, showing the selected policy.

NOTE: If you need to add a product, in the Plan Design Products list, click New 
and complete the fields.

3 From the Show drop-down list, select Product Attributes and scroll down to the 
Attributes list.

4 In the Attributes list, change the appropriate information.

5 From the Show drop-down list, select Product Classes and scroll down to the 
Classes list.

a In the Classes list, click New to associate an employee class with the selected 
product.

b In the Class Name field, click the select button.

c In the Pick Class dialog box, select an employee class from the Class Name 
field and click OK.

NOTE: Only employee classes available for the selected product appear in the 
Pick Class dialog box. You can add employee classes to the list in this dialog box 
by using “Adding Employee Classes” on page 142.

6 From the Show drop-down list, select Product Class Matrix.
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a In the Product Class Matrix list, click the appropriate product column for 
each class. 

A check mark appears to indicate your selection.

NOTE: To delete a check mark, click it.

7 From the Show drop-down list, select Product Class Rate Bands.

a In the Product Class list, select a record with the appropriate product and 
class and scroll down to the Rate Bands list.

b In the Rate Bands list, click New to associate a rate band with the selected 
product and class.

c In the Rate Bands field, click the select button.

d In the Pick Product Rate Bands dialog box, select a Rate Band and click OK.

NOTE: Only available rate bands for the selected product appear in the Pick 
Product Rate Bands dialog box. Rate Bands are created in the Insurance 
Administration > Health and Group Products view. For more information about 
how to add Rate Bands, see “Adding Rate Bands” on page 137. 

NOTE: To generate a proposal for this plan, see “Generating Proposals” on 
page 146.

How Enrollment Waiting Periods Impact the Start of Coverage
You can control how Siebel eHealthcare calculates the start of coverage by defining 
the enrollment waiting period in the Group Policies screen. When you add a Plan 
Design, you define Product Classes that you then associate with a specific product. 
In the Classes list you can specify the Waiting Period, that is the number of days 
that must pass prior to the start of coverage. The actual start of coverage appears in 
the Effective Date field in the Group Policies, Enrollment view. The Waiting Period 
you specify in the Plan Design, Classes list directly impacts this Effective Date.

By default, Siebel eHealthcare has the following defined rules:
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■ If a Waiting Period is specified, the Effective Date is set to the number of waiting 
days from today’s date.

■ If a Waiting Period is not specified, the application checks today's date. If that 
date is before the 15th of the month, the Effective Date is set to the first of the 
month. If that date is after the 15th of the month, the Effective Date is set to the 
first of the following month.

When a user enrolls a new member in the Group Policy, Enrollment view, the 
Effective Date field defaults to a value based on these two rules and the application 
sets the Status field to Waiting. 

The FINS Member Enrollment Rules Workflow enforces these rules. Users can 
invoke this workflow by submitting a Repeating Component Request that repeats 
every 24 hours in batch mode. It will check the Effective Date of existing enrollment 
records and update the Status from Waiting to Active if:

■ The Effective Date of a record is less than or equal to today’s date

■ The Status is still set to Waiting

For more information, see Siebel Server Administration Guide.

To view the FINS Group Policy Member Benefits business component

1 In Siebel Tools, lock the appropriate project.

2 In the Object Explorer, click the Business Component folder to expand the 
hierarchical tree.

3 Search for FINS Group Policy Member Benefits.

4 In the Object Explorer, click the Fields folder.

5 Locate the following fields:

■ Effective Date Cal. This field calculates the Waiting Period.

■ Effective Date Cal Date. This field determines when coverage begins based on 
the values in Effective Date Cal field.

For more information, see Developing and Deploying Siebel eBusiness Applications 
and Siebel Tools Reference.
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Reconfiguring Customizable Products in Plan Design
End users can dynamically reconfigure customizable products by using the 
ReConfig button in the Product Attributes list. The ReConfig button is only available 
if Siebel eConfigurator was installed and the selected product was created as a 
customizable product in Siebel eConfigurator. For more information, see the 
chapters about customizable products in the Product Administration Guide.

To dynamically reconfigure customizable products in plan design

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a group policy.

3 Click the Plan Design view tab.

4 In the Product Attributes list, click ReConfig.

A configuration session launches and a selection page appears. For information 
about customizable product selection pages, see Product Administration Guide.

Generating Proposals
A proposal is a written quote for a policy. Before generating a proposal, end users 
must add the policy, set up classes, and add the policy plan design. Usually, the last 
step in adding the plan design is to activate the software program your company 
uses to rate policies. For more information, see “Designing Plans for Group Policies” 
on page 142.

To generate a proposal

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a policy.

3 Click the Proposals view tab.

4 In the Proposals list, add a record.

5 In the new record, select the appropriate template and complete the contact 
information and the remaining fields.

6 Click Generate Draft.
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Managing Underwriting Information
End users can use the Underwriting and Underwriting Reports view tabs on the 
Group Policies screen to collect and manage underwriting information.

To add underwriting information

1 Navigate to the Group Policies screen.

2 Click the Underwriting Reports view tab.

3 In the Underwriting Reports list, add a record and complete the necessary fields. 

Some fields are described in the following table.

.

To view historical underwriting information

1 Navigate to the Group Policies screen.

Field Comments

Type Type of underwriting report or information being requested. 

Status Status of the current report. Valid options include:

■ Requested

■ Received

■ Submitted

Ordered Date automatically generated by the application when a new record 
is created.

Received Date the underwriting report was received.

Attachments The document containing the requested information. To add an 
attachment:

1 Click the select button.

2 In the Add Attachment dialog box, select the file or type the URL 
linking to the appropriate file.

3 Click Add.

Once a file is attached, users can drill down on the attachment 
hyperlink to view the attached document.
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2 Click the Underwriting view tab.

3 From the Show drop-down list in the Underwriting list, select a type of 
underwriting information:

■ Rates

■ Prior Insurance History

■ Premium/Claim History

■ Large Claimant History

Adding Eligible Members
After a customer accepts a group policy plan, end users can add or make changes 
to eligible members. Eligible members can accept or decline group policy coverages. 
Members who accept coverage can be enrolled in the plan.

To add an eligible member

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a policy.

3 Click the Eligible Members view tab.

4 In the Primary Members list, add a record.

5 In the Add Members dialog box, select an existing record, or add a record and 
complete the necessary fields.

NOTE: During implementation, you will import the eligible members from the 
final census.

Enrolling Members
Group members who accept coverage are enrolled in the policy and are considered 
the primary member of the policy. End users use the Enrollment view to enroll 
eligible members, including the primary member and dependents, who accept 
coverage in the plan.
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To enroll a member

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a policy.

3 Click the Enrollment view tab.

4 In the Primary Members list, select the primary member whom you want to 
enroll and scroll down to the Member Products list.

a In the Member Products list, add a record and complete the necessary fields.

b Repeat Step 4 for each product you would like to add for this primary 
member.

All the products related to this primary member’s enrollment are added.

5 Scroll down to the Insured Members list.

a In the Insured Members list, click New to enroll the primary member and the 
dependents.

b In the Last Name field, click the select button. 

c In the Pick Contacts dialog box, select the primary member that you would 
like to associate with the selected product and click OK.

d In the Insured Members list, complete the remaining fields.

NOTE: Add dependent members in the Pick Contacts dialog box by clicking 
on the New button and completing the fields.

6 Repeat Step 4 and Step 5 for each member you would like to enroll.

When you finish, all enrolled members, including the primary member, appear in 
the Insured Members list.
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Adding Beneficiaries
Some group policies, such as group life insurance policies, require that members 
designate one or more policy beneficiaries. End users can use the Member 
Beneficiary view to add or make changes to group policy beneficiaries.

To add a beneficiary

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a policy.

3 Click the Member Beneficiary view tab.

4 In the Member Life Products list, select a primary member record.

5 Scroll down to the Insured Members list and select a member for whom you 
would like to add a beneficiary.

6 In the Beneficiary list, add a record and complete the necessary fields.

Setting Up Payment Plans
End users can set up payment plans, including details about payment methods, for 
group insurance policies.

To set up a payment plan for a group policy

1 Navigate to the Group Policies screen.

2 In the Policies/Quotes list, select a policy.

3 Click the Bill To view tab.

4 In the Pay Plans list, add a record and complete the necessary fields.

5 Scroll down to the Bill To Address form.

6 In the Last Name field, click the select button.

7 In the Pick Contact dialog box, select a name and click OK.
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Members are individuals who are insured by an organization. In some cases, 
members are also known as policyholders, subscribers, or insureds.

The Members screen allows user to manage insurance policy members. It allows 
end users to add and track information about members with whom they do 
business, such as enrolling them in health programs; changing a member’s 
member’s primary care provider, primary network, or independent practice 
association (IPA); or adding service requests or activities for members. 
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This scenario features sample tasks performed by a call center representative. Your 
company may follow a different workflow according to its business requirements.

In this scenario, a call center representative for a health plan or an insurance 
company is handling multiple calls each day from insurance agents and members.

Typically, members call to ask questions regarding their insurance coverage. The 
call center representative accesses this information in the Members screen, 
Summary view. To enroll members in a health program, she uses the Health 
Programs view. To handle a request for a change of primary care provider (PCP) or 
a primary network or independent practice association (IPA), she goes to the 
Benefits view. To look at the member’s provider history, she uses the Primary Care 
Provider History view.

NOTE: Do not add member records in the Members screen. Use the Group Policies 
screen or the Individual Health Policies screen to add member records. For more 
information, see “Individual Health Policies” on page 119 or “Group Policies” on 
page 131.

Members often call to request information about providers. After the representative 
adds provider records in the Providers screen, she can view them in both the 
Providers screen and the Members screen. In the Members screen, a check mark 
appears in the Provider field of the record, indicating that the member is a provider. 

NOTE: Do not add healthcare provider records in the Members screen. Use the 
Providers screen to add provider records. For more information, see “Providers” on 
page 173.

In this scenario, end users are the call center representatives. They enter 
information to:

■ Enroll a member in a health program

■ Charge a PCP, primary network, or IPA for members

■ Add additional benefits coverage
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Figure 6 illustrates sample tasks that end users typically perform when managing 
members.

Figure 6. Members Sample Tasks
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The following administrator procedure is described in this section:

■ To add a health program

NOTE: Only those with the required administrative responsibilities, such as Siebel 
administrators, can change entries in the Insurance Administration screen.

Adding Health Programs
Health programs are medical programs designed to maintain a member’s health or 
to prevent disease. Health programs include those that offer maternity care or infant 
care, diet and exercise programs, and chronic-illness management programs. You 
can add health programs.

To add a health program

1 From the application-level menu, choose Site Map > Insurance Administration 
> Health Programs.

2 In the Health Programs list, add a record and complete the necessary fields.
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The following end-user procedures are described in this section:

■ To enroll a member in a health program

■ To make changes to member information on page 155

■ To add an additional benefits coverage on page 156

Enrolling Members in Health Programs
Health Programs are medical programs designed to maintain a member’s health or 
to prevent disease. Health programs include those that offer maternity care or infant 
care, diet and exercise programs, and chronic-illness management programs. After 
you add a member, you can enroll the member in a health program.

To enroll a member in a health program

1 Navigate to the Members screen.

2 In the Members list, select the member whom you would like to enroll in a 
health program.

3 Click the Health Programs view tab.

4 In the Health Programs list, add a record and complete the necessary fields.

Changing a PCP or a Primary Network or IPA for Members
If a member changes primary care provider (PCP), primary network, or 
independent practice association (IPA), end users can update Siebel eHealthcare to 
reflect the change.

To make changes to member information

1 Navigate to the Members screen.

2 In the Members list, select a member.

3 Click the Benefits view tab.
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4 In the Benefits list, select the appropriate field and enter the new information as 
follows:

■ Primary Care Provider Last Name. Select a new primary care physician.

■ Primary Network/IPA. Select a new primary network or IPA.

Adding a Member's Additional Benefits Coverage
Additional benefits are called coordination of benefits. Two examples are:

■ When the spouse of a member has the same coverage as the member.

■ When a member has medicare as secondary coverage.

To add an additional benefits coverage

1 Navigate to the Members screen.

2 In the Members list, select a member.

3 Click the Coordination of Benefits view tab.

4 In the Coordination of Benefits list, add a record.

5 In the Add Coordination of Benefits dialog box, perform the appropriate task:

■ Select a record and click OK.

■ Click New to add a new record.

6 In the Coordination of Benefits list, complete the necessary fields.
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Siebel eHealthcare allows you to manage partners and agencies. Partners include 
service providers, aggregators, and insurance agencies. Agencies are organizations 
that act on behalf of insurance companies to sell insurance policies. Agents and 
brokers are the licensed sales representatives who sell the insurance policies. For 
many insurance companies, agencies are often the most important type of partner. 

Tracking partner information is important since for many healthcare companies, 
partners such as banks, agencies, and brokerages often function as a primary 
revenue channel.

NOTE: Adding partners on the Partner screen only allows you to track and monitor 
partner information. If you want to share data with a partner, the partner should be 
upgraded to a Siebel Organization. To perform this and other Partner administration 
tasks, you use the Partners Administration screen. For more information, see Siebel 
Partner Relationship Management Administration Guide.

End users use the Agents screen for healthcare-related procedures such as:

■ Adding agents

■ Viewing agent information

■ Creating service requests or activities for agents

■ Tracking information about contracts, licenses, appointments, registration, 
errors and omissions, policies, and quotes

NOTE: Under the Party Model, where contacts include all persons, individuals added 
in the Agents business component are also members of the Contacts business 
component. Agents are a special subset of contacts who are engaged in the sales of 
Financial Services products.
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These scenarios feature sample tasks performed by a health plan company 
employees. Your company may follow a different workflow according to its business 
requirements.

In these scenarios, the end users are company employees who manage information 
in the field. They enter information to:

■ Create a partner 

■ Add a contact that represents an agency

■ Add new agents 

■ View information about existing agents

■ Track agent information about contracts, licenses, appointments, registration 
status, errors and omissions, policies, and quotes

■ Create service requests or activities for agents

Employee Adds a New Agency
In this scenario, an insurance company uses independent agencies as one of the 
channels for distribution of its insurance products. An employee for this insurance 
company needs to add a newly appointed agency to represent his company’s 
products to consumers.

His company has verified the qualifications of the agency, so he adds information 
about the agent. Then, he adds a new Partners record and adds information about 
the agency’s errors and omissions coverage. 

Next, he navigates to the License & Appointments view to record information about 
the agency’s license. Finally, he adds a contact with the agency.
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Company Signs New Agent
An healthcare company signs a new agent. A licensing and contracting coordinator 
for the company receives an interoffice mail containing the required paperwork. She 
enters the agent’s contact, license, appointment, and contract information into 
Siebel eHealthcare.

Six months later, the agent moves to a new office. He forwards his new address and 
phone number to the sales representative who is his main contact at the healthcare 
company. The sales representative locates the agent in Siebel eHealthcare and 
updates his address and phone number.
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Figure 7 illustrates sample tasks that end users typically perform when managing 
partners and agents.

Figure 7. Partners and Agents Sample Tasks
160 Siebel eHealthcare Guide Version 7.5, Rev. A



Partners and Agents

End-User Procedures
End-User Procedures
The following end-user procedures are described in this section:

■ To create a partner

■ To add an agent on page 161

■ To add additional information about an agent on page 163

Adding New Partners
End users can create new partner records and make changes to existing service 
provider information.

To create a partner

1 Navigate to the Partners screen.

2 In the Partners form, click the show more button, add a record, and complete 
the necessary fields. 

3 In the Partner Type field, select the appropriate type. If this partner is a service 
provider, select Service Provider.

Adding an Agent
Agents are the licensed sales representatives who sell insurance policies. Adding an 
agent is the first step in managing procedures related to the agent. 

To add an agent

1 Navigate to the Agents screen.

2 In the Agents list, add a record and complete the necessary fields.

a In the Partner field, click the select button.

b In the Partners dialog box, select a record and click OK, or click New to add 
a new partner.
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c If adding a new partner, complete the fields.

NOTE: Records in the Agents list contain a few of the most frequently-used 
Agents’ fields. You can add text into additional fields, such as email address, in 
the More Info form. In addition, you can add or change the columns displayed 
in the list, by clicking the list’s menu button and choosing Columns Displayed.
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Adding Information Associated with a Agent
Using the view tabs on the Agents screen, you can track additional information 
related to agents including information about contracts, licenses and appointments, 
errors and omissions, National Association of Securities Dealers (NASD) 
registration, and policies and quotes.

To add additional information about an agent

1 Navigate to the Agents screen.

2 In the Agents list, select an agent and click the appropriate view tab from the 
following list:

■ Contracts. To add information about the agent’s contracts.

■ Licenses and Appointments. To add information about licenses the agent holds.

■ Errors and Omissions. To add information about the agent’s errors and 
omissions.

■ Registration. To add information about the agent’s registration status.

■ Policies/Quotes. To view policies and quotes for the agent you selected.

3 In the selected view list, add a record and complete the necessary fields.
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Siebel eHealthcare allows you to track referrals to other providers and 
authorizations of specific healthcare services. Service agents use the 
Referrals\Authorizations screen to collect the information required for referral and 
authorization approval, validate the fields, initiate workflow, and track the status 
on behalf of a provider, member, or other inquiring party. This information can then 
be integrated with back office systems using a prebuilt referral and authorization 
ASI. For more information, see “Integration” on page 191.
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The following business scenario features sample tasks performed by a call center 
representative for health plan company. Your company may follow a different 
workflow according to its business requirements. 

A healthcare provider calls a health plan’s call center in order to refer a patient to 
an orthopedic surgeon. A call center representative receives the call from the 
provider. The call center representative first authenticates the provider and then 
looks up the member on the Members screen. By looking at the Member Summary 
view, she verifies the member’s basic eligibility and coverages. She then navigates 
to the Referrals/Authorizations screen. She creates a new referral and completes the 
necessary fields. Once she finishes entering the necessary data, she changes the 
value in the Status field to Open and sets the Sub-status field to Submitted.
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Referrals and Authorization Sample Tasks
This section details sample tasks often performed by administrators and end users 
when managing referral and authorization approval information. Your company 
may follow a different workflow according to its business requirements. 

Administrator Procedures
The following list shows procedures administrators typically perform to administer 
referrals and authorizations.

■ Create activity plan templates. For more information, see “To create an activity 
plan template” on page 168.

■ Create activities for an activity plan template. For more information, see “To create 
activities for the template” on page 168.

End-User Procedures
The following list shows tasks end users typically perform when creating referrals 
and authorizations.

■ Create a referral or authorization. For more information, see “To create a referral or 
authorization” on page 169.

■ Record actions related to referrals or authorizations. For more information, see “To 
record referral or authorization actions” on page 170.

■ Associate a referral or authorization with a provider, department, clinic, drug, lab, test, 
or type of medical equipment. For more information, see “To record referral or 
authorization decisions” on page 171.

■ Add attachments related to referrals or authorizations. For more information, see 
“To add attachments related to referrals and authorizations” on page 172.
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The following administrator procedures are described in this section:

■ To create an activity plan template

■ To create activities for the template

Activity Plan Templates allow you to create and manage activities related to referrals 
and authorizations. You define templates using the Application Administration 
screen’s Activity Templates and Activity Template Details views. 

To create an activity plan template 

1 From the application-level menu, choose View > Site Map > Application 
Administration > Activity Templates.

2 In the Activity Plan Templates list, add a record. 

3 In the Name field, type a name for the template.

4 In the Type field, choose FINS Referrals Authorizations.

5 Complete the remaining necessary fields.

For more information, see Applications Administration Guide.

To create activities for the template 

1 From the application-level menu, choose View > Site Map > Application 
Administration > Activity Templates.

2 In the Activity Plan Templates list, select a template.

3 Click the Activity Template Details view tab. 

4 In the Activity Template Details list, add a record.

5 Complete the necessary fields for each activity assigned to the template.

6 From the drop-down list, choose an activity type.

NOTE: Repeat Step 2 through Step 6 to add activities to the template. 

7 Save the activity.
168 Siebel eHealthcare Guide Version 7.5, Rev. A



Referrals and Authorization

End-User Procedures
End-User Procedures
The following end-user procedures are described in this section:

■ To create a referral or authorization

■ To record referral or authorization actions on page 170

■ To record referral or authorization decisions on page 171

■ To add attachments related to referrals and authorizations on page 172

Managing Referrals or Authorizations
End users use the Referrals/Authorization view to record the necessary information 
for processing a referral or authorization. Using the Referrals/Authorization form 
and More Info view tab, users can verify they have recorded all the required 
information, check on member eligibility, and track the status of referrals and 
authorizations.

To create a referral or authorization

1 Navigate to the Referrals/Authorization screen.

2 In the More Info form, add a record and complete the necessary fields. 

Some fields are described in the following table.

.

Field Comments

Referral/
Authorization #

Automatically generated by the application.

Type Determines whether the record is a referral or authorization.

Last Name Last name of the member. The application automatically populates 
the First Name field.

For more information on adding members, see “Adding Eligible 
Members” on page 148.
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End users can use the Actions view tab to record activities related to a referral or 
authorization. For more information on creating activity plan templates, see “To 
create an activity plan template” on page 168.

To record referral or authorization actions

1 Navigate to the Referrals/Authorization screen.

2 Click the Actions view tab.

3 In the Actions list, add a new record and complete the necessary fields.

Status Status of this referral or authorization. Valid options include:

■ Open

■ Pending

■ Closed

■ Cancelled

■ Exception Handling

Requestor Last 
Name

Last name of provider. The application automatically populates the 
Requestor First Name field.

For more information on adding providers, see “Adding Providers” 
on page 178.

Diagnosis Codes Diagnosis code for this referral or authorization.

For more information on adding codes, see the discussion on 
modifying the List of Values (LOV) in Applications Administration 
Guide.

Maximum Visit 
#

Maximum number of visits for this referral or authorization.

Procedure 
Codes

Procedure code for this referral or authorization.

For more information on adding codes, see the discussion on 
modifying the List of Values (LOV) in Applications Administration 
Guide.

Benefits 
Amount

The maximum dollar amount for the specified benefit.

Field Comments
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4 To add a new activity, add a new record in the Activities list and complete the 
necessary fields.

End users can use the Decision History view tab to associate a referral or 
authorization with a provider, department, clinic, drug, lab, test or medical 
supplies.

To record referral or authorization decisions

1 Navigate to the Referrals/Authorization screen.

2 Click the Decision History view tab.

3 In the Approved Actions form, add a record and complete the necessary fields. 

Some fields are described in the following table.

.

Field Comments

Type The type of referral or authorization decision. Valid options include:

■ Lab - Lab referral or authorization.

■ Test - Medical test referral or authorization.

■ DME - Authorization for durable medical equipment, for 
example, wheelchair.

■ Rx - Specified drug treatment. 

Description Description of this referral or authorization.

Equipment # Equipment identification number. 

Rx Drug The specific drug treatment requested by the provider. If the 
provider requests a unauthorized drug, then they must indicate the 
quantity, dosage, and expected treatment before submitting the 
request. 

Rx Dosage The specific dosage of the requested drug treatment. If the provider 
requests a unauthorized drug, then they must indicate the quantity, 
dosage, and expected treatment before submitting the request. 
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4 In the Approved Providers and Facilities list, add a record and complete the 
necessary fields.

Some fields are described in the following table.

To add attachments related to referrals and authorizations

1 Navigate to the Referrals/Authorization screen.

2 Click the Attachments view tab.

3 In the Attachments list, add a record.

4 In the Attachment Name field, click the select button.

5 In the Add Attachment dialog box, do one of the following:

■ Click Browse, and select the file to be added as an attachment.

■ In the URL field, type a URL to the file to be added as an attachment.

6 Click Add.

The remaining fields are automatically updated using the selected file’s 
properties.

Field Comments

Provider Last 
Name

Last name of the provider. The application automatically populates 
the Provider First Name and ID#.

For more information on adding providers, see “Adding Providers” 
on page 178.

First Name First name of the member. For more information on adding 
members, see “Enrolling Members in Health Programs” on 
page 155.

Facility The facility where the treatment will be performed. The application 
automatically populates the remaining fields.

For more information on adding facilities, see “Adding Facilities” on 
page 115.
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Providers are healthcare professionals who are paid by, or file claims with, your 
health plan or health insurance company. Examples of providers are physicians, 
nurse practitioners, dentists, and pharmacists.

The Providers screen allows end users to manage information about providers. 
Specifically, it allows end users to add and track information about providers and 
contracts, locate providers, associate facilities with a provider, indicate a provider’s 
specialties, add profile information (such as provider skills, background, and 
business locations and hours), add some provider claims (such as, an out-of-
service-area claim), view payment information, and print a Provider report.
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This scenario features sample tasks performed by a contracting specialist, a 
provider relations representative, and a member service representative. Your 
company may follow a different workflow according to its business requirements.

In this scenario, a contracting specialist for a health plan is responsible for 
managing information about the healthcare providers with which her company 
does business. She just established a contract with a single provider.

She adds the new provider and then adds information about the provider’s area of 
specialization. Next, she adds information about the provider’s primary location 
(for example, a medical group or pharmacy), affiliations (such as hospitals or health 
networks), and whether or not hospital affiliations include admitting privileges. 
After that, she adds information about the provider’s skills, background, and clinic 
locations and hours. Then she adds information about contracts the provider holds 
with her company and adds the provider’s payment preferences.

A provider relations representative provides service for the provider. He uses the:

■ Encounters view and the Claims view to refer to reports regarding patient visits 
and claims

■ Payments view to refer to payments made to the provider

■ Service Requests view to add service requests such as referral inquiries

■ Alerts view to add important notes about this provider

A member service representative uses Siebel eHealthcare to answer questions about 
contracted providers. Using the Provider Locator, she searches for providers by city, 
state, or ZIP Code. She views and prints Provider reports based on the product and 
speciality. Also, she can view some of the information the contracting specialist 
adds in the Providers screen and the Products screen. For example, the Products 
screen displays information about providers in the Primary Providers view and the 
Contracted Providers view.

In this scenario, end users are health plan contracting specialists, provider relations 
representatives, and member service representatives. They use Siebel eHealthcare 
to:

■ Add a new providers and provider addresses
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■ Associate a facility with a provider

■ Associate a specialty with a provider and add profile information

■ Add a provider contract

■ View provider payments

■ Add a provider claim

■ View and print provider reports
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Providers Sample Tasks
Figure 8 illustrates sample tasks that end users typically perform when managing 
providers.
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Figure 8. Providers Sample Tasks
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The following end-user procedures are described in this section:

■ To add a provider

■ To add a provider address on page 179

■ To associate a facility with a provider on page 179

■ To associate a specialty with a provider on page 180

■ To add profile information on page 181

■ To add a provider contract on page 181

■ To view a provider payment on page 182

■ To add payments manually on page 182

■ To add a provider claim on page 183

■ To view a report on page 183

Adding Providers
End users use the Providers screen to add or make changes to healthcare provider 
records. After they add provider records in the Providers screen, users can view 
them in the Providers and the Contacts screen. In the Contacts screen, a check mark 
appears in the Provider field of the record, indicating that the contact is a provider.

NOTE: End users can add healthcare provider records in the Contacts screen. 
However, they will not appear in the Providers screen unless they check the 
Providers check box on the More Info view tab.

To add a provider

1 Navigate to the Providers screen.

2 From the Show drop-down list, select My Providers.

3 In the Providers list, add a record and complete the necessary fields.
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Adding Addresses for the Provider Locator
Users must add provider addresses if they want to use the Provider Locator feature.

To add a provider address

1 Navigate to the Providers screen.

2 From the Show drop-down list, select My Providers.

3 In the Providers list, select a provider and click the Addresses view tab.

4 In the Addresses list, add a record.

5 In the Add Address dialog box, perform the appropriate task:

■ To choose an existing record, select a record and click OK.

■ To add a new record, click New and complete the fields.

6 In the Addresses list, click Update Geo Code.

NOTE: The latitude and longitude values will not generate if any one value in the 
City, State, Zip Code, or Country fields is incorrect. For example, if the ZIP Code is 
incorrect, you will receive an error message. To correct this problem, navigate to the 
Application Administration, ZIP Code Administration view and make sure the Geo 
values for that city, state, and ZIP Code combination has been loaded. For more 
information, see Siebel eService Administration Guide.

Associating Facilities with Providers
A provider may be affiliated with one or more facilities. For example, a provider may 
work at both a clinic and a hospital. End users can use the Affiliations view to 
associate facilities, such as clinics, hospitals, or pharmacies, with providers.

To associate a facility with a provider

1 Navigate to the Providers screen.

2 From the Show drop-down list, select My Providers.

3 In the Providers list, select a provider.
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4 Click the Affiliations view tab.

5 In the Affiliations list, add a new record.

6 In the Facilities dialog box, perform the appropriate task:

■ To choose an existing record, select a record and click OK.

■ To add a new record, click New and complete the fields.

Associating Specialties with Providers
Many providers have an area of medical specialization. End users can use the 
Specialties view to indicate a provider’s area of medical specialization by 
associating specialities with providers.

To associate a specialty with a provider

1 Navigate to the Providers screen.

2 From the Show drop-down list, select My Providers.

3 In the Providers list, select a provider.

4 Click the Specialties view tab.

5 In the Specialties list, add a record and complete the necessary fields.

NOTE: To add a new Specialty, you must add a new value to the List of Values (LOV) 
by specifying the Type as FINS_AGDESG_HLTHSPEC_MLOV. For more information, 
see Applications Administration Guide.
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Adding Profile Information
End users can use the Profile view to add profile information for providers. Profile 
information includes provider skills, background, business hours, and business 
locations.

To add profile information

1 Navigate to the Providers screen.

2 From the Show drop-down list, select My Providers.

3 In the Providers list, select a provider.

4 Click the Profile view tab.

5 In the Skills and Background form, complete the necessary fields.

6 Scroll down to the Hours & Locations list.

7 In the Hours & Locations list, add a record and complete the necessary fields.

Adding Provider Contracts
A company may have one or more contracts with each provider with whom they do 
business. Each contract may have different terms, payment preferences, and 
payment methods. End users can use the Contracts view to add contracts with 
providers.

End users can set up different payment arrangements and methods for each 
provider contract.

To add a provider contract

1 Navigate to the Providers screen.

2 From the Show drop-down list, select My Providers.

3 In the Providers list, select a provider.

4 Click the Contracts view tab.
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5 In the Contracts list, add a record and complete the necessary fields.

The contract is added for the provider.

6 Scroll down to the Payment Preferences form.

7 In the Payment Preferences form, from the drop-down list, select one of the 
following:

■ Payment Preferences - Check. To pay using a check.

■ Payment Preferences - EFT. To pay using an electronic funds transfer.

8 In the selected Payment Preferences form, complete the necessary fields.

Viewing Provider Payments and Adding Payments Manually
End users can use the Payments view to review information about payments their 
company makes to providers. Payment information can include payment amount, 
payment date, payment adjustments, and reason for payment.

To view a provider payment

1 Navigate to the Providers screen.

2 From the Show drop-down list, select My Providers.

3 In the Providers list, select a provider.

4 Click the Payments view tab.

Provider payments are usually imported from an external billing system. You can 
add payments manually in the Providers list.

To add payments manually

1 Navigate to the Providers screen.

2 From the Show drop-down list, select My Providers.

3 In the Providers list, select a provider.

4 Click the Payments view tab.
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5 In the Payments list, add a record and complete the necessary fields. 

NOTE: You can scroll down to the Payment Details form to see additional fields.

Adding Provider Claims
A contract with a provider may specify that the provider is paid for each member 
visit or service. If so, providers or members may contact your company to initiate 
claims for payment. End users can use the Claims view to add claims for providers.

To add a provider claim

1 Navigate to the Providers screen.

2 From the Show drop-down list, select My Providers.

3 In the Providers list, select a provider.

4 Click the Claims view tab.

5 In the Claims list, add a record.

6 In the Add Claims dialog box, perform the appropriate task:

■ To choose an existing record, select a record and click OK.

■ To add a new record, click New and complete the fields.

NOTE: You can scroll down to the Claims form and complete additional fields.

Viewing and Printing a Provider Report
Provider reports can be viewed and printed by product and speciality.

To view a report

1 Navigate to the Providers screen.

2 From the Show drop-down list, select My Providers.

3 From the application-level menu, choose View > Reports.
Version 7.5, Rev. A Siebel eHealthcare Guide 183



Providers

End-User Procedures
4 In the Providers dialog box, in the Select a Report drop-down list, select one of 
the following and click Run:

■ Provider by Speciality. Lists all the providers and their general information, 
sorted by their specialities (such as dermatology and pediatrics)

■ Provider by Product. Lists all the providers with general information in the 
order of products (such as HMO Plus and PPO) with which they are 
contracted.

The Provider report appears in the Siebel Report Viewer.

5 To print the report, in the Siebel Report Viewer window, click the print button.

6 To return to the Providers list, in the Siebel Report Viewer window, click the 
close button.
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To handle the payment of policy premiums, insurance companies use something 
called a billing account. A billing account is a construct that is used to handle the 
billing and payment activities associated with one or many insurance policies. The 
policy premiums are billed and collected through the billing account. This allows 
insurance companies to give users the flexibility to pay their premiums through a 
single bill, even though they may have several policies.

Siebel eHealthcare provides flexibility for companies to handle billing-oriented 
transactions in various ways. Although billing accounts are a popular method 
within the industry, many companies handle billing on a single policy basis and 
many use a blend of billing account and single policy billing.

Using the procedures given in this chapter, end users will be able to use the Billing 
Accounts screen to add a billing account, associate a billing account with a policy, 
contact, or company, and add a service request to a billing account.
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This scenario features sample tasks performed by an insurance agent. Your 
company may follow a different workflow according to its business requirements.

An insurance agent creates a new billing account to manage the various policies 
held by one of her customers. First, she associates the policies and certain contacts 
with the billing account. In this context, a contact can be someone who is 
responsible for paying the bills associated with an account or someone associated 
with the billing account, such as the secondary insured on a policy. 

Later, the insurance agent receives a call from one of her contacts. The contact has 
a problem with his latest bill. The insurance agent logs a service request against the 
customer’s billing account.
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Billing Accounts Sample Tasks
This section details sample tasks often performed by end users when working with 
billing accounts. Your company may follow a different workflow according to its 
business requirements. 

End-User Procedures
The following list shows tasks end users typically perform when working with 
billing accounts. 

■ Create new billing accounts. For more information, see “To add a billing account” 
on page 188.

■ Associate a billing account with a policy, contact, or company. For more information, 
see “To associate a billing account with a policy” on page 189 and “To associate 
a billing account with a contact or a company” on page 190.

■ Add a service request to a billing account. For more information, see “To add a 
service request to a billing account” on page 190.
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The following end-user procedures are described in this section:

■ To add a billing account

■ To associate a billing account with a policy on page 189

■ To associate a billing account with a contact or a company on page 190

■ To add a service request to a billing account on page 190

Creating a Billing Account Record
End users can add a new billing account record from any Billing Accounts view, 
including the Contacts screen, the Companies screen, the Service Requests screen, 
or the Billing Accounts screen.

To add a billing account

1 Navigate to the Billing Accounts screen.

2 In the More Info form, add a record and complete the necessary fields. 

Some fields are described in the following table.

Field Comments

Account # Automatically generated by the application. You can configure 
Siebel eHealthcareto assign a billing account number based on 
your company’s standards and conventions.

Effective Date Set to the current date.

Status Set to New.

Type The type of billing account. Select:

■ Single Policy if you will associate only one policy with the 
billing account.

■ Multiple Policy if you will associate more than one policy with 
the billing account.
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Associating Billing Accounts with Other Records
Billing accounts can be associated with policies, contacts, companies, service 
requests, and households. End users can make the associations directly from the 
Billing Accounts screen, the Contacts Billing Accounts view, or the Companies 
Billing Accounts views. 

Billing accounts can only be associated with households through an implicit 
relationship with a contact. That is, a billing account must be associated with a 
contact who is a member of a household in order for the billing account to be 
associated with the household. This relationship is then visible in the Households 
Billing Accounts view.

To associate a billing account with a policy

1 Navigate to the Billing Accounts screen.

2 In the Billing Account list, select the billing account for which you want to 
associate a policy.

3 Click the Policies view tab.

4 In the Policies list, add a record.

The Add Policy dialog box appears.

5 Do one of the following:

■ If the policy already exists, select the policy in the Add Policy dialog box.

■ If the policy does not yet exist, click New to create a new policy.

The Add Policy dialog box closes and a record is added to the Policies list.

6 Complete the necessary fields.

The policy is now associated with the billing account.

NOTE: The billing account type determines how many policies should be 
associated. If the type is Single Policy, then only one policy should be associated.
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To associate a billing account with a contact or a company 

1 Navigate to the Billing Accounts screen.

2 In the Billing Account list, select a billing account with which you want to 
associate a contact or a company.

3 Click the Contacts view tab.

4 Do one of the following:

■ In the Contacts list, click New and either select or add a contact in the Add 
Contact dialog box.

■ In the Organizations list, click New and either select or add a company in the 
Add Companies dialog box.

The selected contact or company is now associated with the billing account.

To add a service request to a billing account

1 Navigate to the Billing Accounts screen.

2 In the Billing Account list, select a billing account that you want to associate a 
service request.

3 Click the Service Requests view tab.

4 In the Service Requests list, add a record and complete the necessary fields. 

A new service request record appears, with an automatically generated SR #. 
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The Siebel Financial Services eBusiness platform combines a set of tools, 
technologies, and prebuilt functional integration components to facilitate 
application integration. This set of products are referred to as Siebel Financial 
Services eBusiness Application Integration (eAI). Siebel Financial Services eAI is an 
EAI solution built on top of Siebel eAI offered by Siebel Systems. Siebel Financial 
Services eAI provides an integration solution using industry XML standards. These 
standards have been adopted by the industry and extended by middleware 
companies such as IBM MQSFSE. 

Siebel Financial Services eAI is designed as a set of interfaces that interact with each 
other and with other components within the Siebel application. These interfaces: 

■ Allow configurable messages within Siebel Tools for exchanging information 
using the various industry XML standards.

■ Expose internal Siebel Objects to external applications.

■ Take advantage of prebuilt adapters and enterprise connectors, and are 
compatible with third-party adapters and connectors.

■ Allow prebuilt XML connectors for Siebel applications.

■ Allow for comprehensive data transformation.

■ Allow extension for customized XML connectors by providing the Siebel 
Industry XML Connector Factory API.

For more information on Siebel eAI, see Siebel Financial Services eBusiness 
Application Integration Guide and Overview: Siebel eBusiness Application 
Integration Volume I.
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Siebel eHealthcare includes a number of integration messages designed to support 
key business processes for the healthcare industry. Table 5 describes these 
messages by defining the message type, the message purpose, the target 
application, and where you can find more information about it.

Table 5. Siebel eHealthcare Integration Messages

Type Message Target Application Description

ASI Request Add/Cancel 
Group Policy Member

Policy Administration 
System

A message to add or cancel a group 
policy member.

For information, see Application 
Services Interface Reference: Siebel 
eBusiness Application Integration 
Volume VI.

ASI Response Add/Cancel 
Individual Policy Member

Policy Administration 
System

A message to add or cancel an 
individual policy member.

For information, see Application 
Services Interface Reference: Siebel 
eBusiness Application Integration 
Volume VI.

ASI Request Authorization Referrals and 
Authorizations System

A message to search for appropriate 
providers.

For information, see Application 
Services Interface Reference: Siebel 
eBusiness Application Integration 
Volume VI.

ASI Request Benefit Detail Benefits System A message to submit information 
required for determining eligibility.

For information, see Application 
Services Interface Reference: Siebel 
eBusiness Application Integration 
Volume VI.
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ASI Request Member Details 
Update

Membership System A message to update demographic and 
contact details for a member.

For information, see Application 
Services Interface Reference: Siebel 
eBusiness Application Integration 
Volume VI.

ASI Request Preliminary 
Rating

Rating Engine A message to request a preliminary rate 
based on census and plan information.

For information, see Application 
Services Interface Reference: Siebel 
eBusiness Application Integration 
Volume VI.

ASI Request Providers Provider System A message requesting benefit detail.

For information, see Application 
Services Interface Reference: Siebel 
eBusiness Application Integration 
Volume VI.

ASI Request Referral Referrals and 
Authorizations System

A message to submit authorization 
request.

For information, see Application 
Services Interface Reference: Siebel 
eBusiness Application Integration 
Volume VI.

ASI Update Provider Details Provider System A message to update the demographic 
and contact details for a provider.

For information, see Application 
Services Interface Reference: Siebel 
eBusiness Application Integration 
Volume VI.

VCML Request Claim Status 
Date Request

Claim Administration 
System

A request message for claim status and 
date. 

VCML Request Claim Status 
Date Response

Claim Administration 
System

The response message to a request 
message for claim status and date. 

Table 5. Siebel eHealthcare Integration Messages

Type Message Target Application Description
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VCML Request Claims 
Adjudication Request

Claim Administration 
System

A message submitting claims detail to 
request for adjudication. 

VCML Request Claims 
Adjudication Response

Claim Administration 
System

The response message to an 
adjudication request. It may contain 
advice of amount payable and 
Explanation of Benefits. 

Table 5. Siebel eHealthcare Integration Messages

Type Message Target Application Description
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Table 6 lists the Actuate reports that are specific to the Siebel eHealthcare. For more 
information about Actuate reports, including how to customize, enhance, and 
create Siebel reports, see Siebel Reports Administration Guide.

Table 6. Siebel eHealthcare Reports

Report Name and Description Navigation Path Report Selection

FINS Call Report Detail
Displays call report details, participating 
contacts and employees, action items, 
and notes of a single call report.

Call Reports > My Call 
Reports 

Detail

FINS Call Report Summary
Displays the company profile of 
commercial banking clients including a 
corporate summary, financial profile, 
subsidiaries, contacts, and activities.

Call Reports > My Call 
Reports

Summary

FINS Contact Profile
Displays contact profile information such 
as name, address, date of birth, interests, 
experience, and activities.

Contacts > My Contacts Profile

FINS Demo Health Providers by Product - 
Healthcare
Displays lists of healthcare providers, 
grouped by health insurance product, 
with their contact and location 
information.

Providers > My 
Providers

Provider by 
Product
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FINS Demo Health Providers by Specialty - 
Healthcare
Displays lists of healthcare providers, 
grouped by their specialty, with their 
contact and location information.

Providers > My 
Providers

Provider by 
Specialty

Opportunities - By Product Line Opportunities > My 
Opportunities

By Product Line

Table 6. Siebel eHealthcare Reports

Report Name and Description Navigation Path Report Selection
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account, as used in Financial Services 20
activity plan template

activities, creating for 138
group policies, creating for 138
referral and authorization, creating 168

Actuate reports, table of 195
administration procedures

health program, adding 154
health programs, adding 154

agencies
agent, adding 161
agent, adding information about an 

agent 163
company signs new agent business 

scenario 159
defined 157
employee adds a new agency business 

scenario 158
note, about sharing data with 

partner 157
partner, creating 161
partners sample tasks (diagram) 160
Party Model, about 157

agent
adding 161
information, adding information about an 

agent 163
applicants

individual health policies, adding 
applicant 127

policy coverages, associating with 129
application integration. See integration
assessment

company assessment, performing 59

company value assessment, viewing the 
results 60

Assignment Manager, about using to resolve 
coverage team problems 48

attachments
referrals and authorization, adding 172

attachments, associating group policies 
with 141

audience for guide 11
authorizations

activities, creating for template 168
activity plan template, creating 168
attachments, adding 172
authorization actions, recording 170
authorization decisions, recording 171
business scenario 166
creating a authorization 169

Auto Call Report Workflow
activating 104
modifying 105

B
beneficiary

group policy, adding beneficiary to 150
billing accounts

about 185
billing account records, adding or 

modifying 188
business scenario 186
contact or company, associating billing 

account with 190
policy, associating a billing account 

with 189
service request, adding to a billing 

account 190
Version 7.5, Rev. A Siebel eHealthcare Guide 197



billing information, adding for a payment 
plan 130

book of clients. See contacts, logical 
groupings of contacts

C
call reports

See also call reports, administrator 
procedures

action items, associating with 109
attachments, associating with 109
attachments, storage location 106
business scenario 100
call report records, adding 106
defined and about 99
distribution list, about creating 108
distribution list, creating 

(procedure) 108
emailing 110
notes, associating with 109
printing 110
privacy flags, setting 109
tasks, samples when managing call 

reports (diagram) 102
call reports, administrator procedures

See also call reports
call report records, creating 

automatically 104
chart for your call reports, viewing 103

categories, adding contact to 77
Category field, adding products 123
census

information, adding (companies) 66
information, adding (group 

policies) 140
policy, associating with 141

claim
facility claim, adding 118

claims
provider claims, adding 183

Collapse button
edit layout button, about 22
summary view control, about 21

companies
See also companies, administrator 

procedures
administrators and end uses sample 

tasks, diagram 45
billing account, associating with 190
business scenario, sales representative 

collects census data 44
business scenario, sales representative 

tracks company information 43
company hierarchies, about 42
company, adding 56
contact, associating with a company 76
Siebel eFinance, as used in 41

companies, administrator procedures
See also companies
aggregated activities for a company, 

viewing 57
aggregated coverage team for a company, 

viewing 58
aggregated list of contact for a company, 

viewing 59
aggregated opportunities for a company, 

viewing 58
application, associating with a 

company 61
census information, adding 66
company assessment, performing 59
company information, deleting 46
company relationship hierarchy, about 

viewing 64
company summary information, 

viewing 63
company unavailable to all other users, 

making 46
company value assessment, viewing the 

results 60
competitor, indicating that a company 

is 47
competitor, information, about 

deleting 48
coverage team members, about 

verifying 48
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deleting members 49

coverage team members, searching for a 
company without 49

coverage team, adding a member to 63
custom-defined relationship, 

creating 65
data aggregation, about generation 

company hierarchies for 51
default company hierarchy, generating 

(procedure) 52
dynamic company hierarchy, creating of 

selected companied 53
natural parent-subsidiary relationship, 

establishing between two 
companies 65

primary team member, changing for a 
company 49

relationship type, adding a custom-
defined 50

service request, associating with a 
company 62

company hierarchies
aggregated activities for a company, 

viewing 57
aggregated coverage team for a company, 

viewing 58
aggregated list of contacts for a company, 

viewing 59
aggregated opportunities for a company, 

viewing 58
company relationship hierarchy

about viewing 64
custom-defined relationship, 

creating 65
natural parent-subsidiary relationship, 

establishing between two 
companies 65

company summary, viewing 63
competitor information, managing

competitor information, about 
deleting 48

competitor, indicating that a company 
is 47

contacts
adding a contact 75
aggregated list of contacts for a company, 

viewing 59
billing account, associating with 190
business scenario, sales representative 

adds a new contact 71
categories, adding to a contact 77
company, associating a contact with 76
contact summary information, 

viewing 82
customer value assessment, about 

creating 81
customer value assessment, about 

viewing the results 82
customer value assessment, creating 

(procedure) 81
customer value assessment, viewing the 

results (procedure) 82
defined 69
household, adding to a 93
logical groupings of contacts, 

creating 85
logical groupings of contacts, 

evaluating 85
My Personal Contacts view, about adding 

a company record 75
note records, creating 78
referral received, entering 79
referral to a contact, creating 80
relationship hierarchy, about viewing 83
relationship hierarchy, defining 

relationship between contacts 84
relationship hierarchy, viewing 

(procedure) 83
Contacts screen

providers, viewing 152
coverage team members

about verifying 48
company, adding or deleting 

members 49
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coverage 49

member, adding to 63
primary coverage team member, changing 

for a company 49
customer value assessment

about creating 81
creating (procedure) 81
results, about viewing 82
results, viewing (procedure) 82

D
data aggregation

company hierarchies, about generating 
for 51

default company hierarchies, about 52
default company hierarchy, generating 

(procedure) 52
dynamic company hierarchies, about 53
dynamic company hierarchies, creating of 

selected companies 53
default company hierarchies

about 52
generating (procedure) 52

distribution list
See also call reports
about creating 108
creating (procedure) 108

dynamic company hierarchies
about 53
selected companies, creating 53

E
eligible member, adding 148
emailing a call reports 110
employee class, adding 142
enrollment

in health programs 155
enrollment waiting period, impact on start 

of coverage 144
Expand button

edit layout button, about 22

summary view control, about 21

F
facilities

about 111
adding a facility 115
business scenario 112
facility claim, adding 118
facility contract, adding 117
facility locator, adding a facility to 114
facility payment, adding 117
provider, facility or contract, associating 

with a facility 116
sample tasks (diagram) 113

Facilities screen
facility locator 114

facility locator, adding facilities 114
financial accounts

account holdings, comparing against 
portfolio model 97

account holdings, viewing by sector 98
accounts, viewing past performance 98
aggregated holdings, viewing 97
expected future cash flows, viewing for 

selected accounts 98
household, selecting associated with 97

financial application
company, associating with 61
opportunity, creating from 37

FINS Group Policy Member Benefits 
business component, viewing 145

G
group policies

See also life insurance
activities plan template, creating activities 

for 138
activity plan template, creating 138
attachments, adding associated with a 

group policy 141
beneficiary, adding 150
business scenario 133
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census information, adding 140
census, associating with a policy 141
customizable products, reconfiguring in 

plan design 146
defined 131
designing plans for, lists available in Plan 

Design view 142
eligible member, adding 148
employee class, adding 142
enrollment waiting periods, impact on the 

start of coverage 144
FINS Group Policy Member Benefits 

business component, viewing 145
group insurance product, adding 136
historical underwriting information, 

viewing 147
member, enrolling 149
payment plan, setting up 150
plan design, adding 143
policy record, adding 139
policy screens, views common to all 

(table) 132
proposal, generating 146
rate band, adding 137
underwriting information, adding 147

guide
audience for 11
organization of 12

H
health policies, individual

about 119
applicant, adding 127
billing information, adding for a payment 

plan 130
business scenario 120
health risk assessment, performing 128
insurance product, adding 123
payment plan for individual health policy, 

setting up 130
policy coverages, associating with an 

applicant 129
product line type, specifying 123

quote to an active policy, converting 128
quotes, providing 125
rate band, adding 124
service requests, adding 129

health program, adding 154
health programs, adding 154
health risk assessment, performing 128
Hide button

edit layout button, about 22
summary view control, about 21

households
account holdings, comparing against 

portfolio model 97
account holdings, viewing by sector 98
accounts, viewing past performance 98
business scenario 89
contact, adding to a household 93
defined 87
expected future cash flow, viewing for 

selected accounts 98
financial account, selecting associated 

with 97
financial account, viewing aggregated 

holding 97
household, adding a 92
portfolio information, perspectives 

available (list of) 96
relationship hierarchy, about viewing 95
relationship hierarchy, creating custom-

defined 95
summary information, viewing 94
tasks, samples when managing 

households (diagram) 91

I
insurance policy, associating with billing 

account 189
insurance products, adding 137
integration

about 191
Siebel eHealthcare integration messages, 

table of 192
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L
life insurance

See also group policies
LOV, adding a custom-defined relationship 

type 50

M
member, enrolling in group policy 149
Members screen

about 151
members, enrolling 155

Mobile Web Client, caution, about 
performing administrative functions on 
local db 19

Move down edit layout button, about 22
Move up edit layout button 22

N
notes, creating for a contact 78

O
opportunities

See also opportunities, administrator 
procedures

aggregated opportunities for a company, 
viewing 58

business scenario, sales representative 
creates new opportunity 26

defined 25
deleting if unsure whether opportunity is 

active 28
financial application, creating 

opportunity from 37
opportunity details, adding specific 37
persistent filter, deleting 39
persistent filter, entering and running 38
persistent filter, saving 39

Opportunities persistent filter
limitations 34
LOV, adding a field with 31
picklist field, adding to 32

opportunities, administrator procedures

See also opportunities
Opportunities persistent filter, adding a 

field with a LOV to 31
Opportunities persistent filter, adding a 

picklist field to 32
opportunity persistent filters, 

limitations 34
opportunity, adding from the Data 

Administration screen 28
opportunity, securing an 30
primary sales team member, changing for 

an opportunity 29
sales team members, adding or deleting 

for an opportunity 29
organization of guide 12

P
partners

agent, adding 161
agent, adding information about an 

agent 163
company signs new agent business 

scenario 159
creating a partner 161
defined 157
employee adds a new agency business 

scenario 158
note, about sharing data with 

partner 157
partners sample tasks (diagram) 160
Party Model, about 157

Party Model, about 157
payments

billing information, adding for a payment 
plan 130

facility payment, adding 117
individual health policy, setting up 

payment plan 130
payment plans, setting up for group 

policies 150
provider payments, adding 

manually 182
provider payments, viewing 182
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persistent filter
Opportunities persistent filter, adding a 

field with a LOV to 31
Opportunities persistent filter, adding a 

picklist field to 32
Opportunities persistent filters, 

limitations 34
opportunities, deleting persistent 

filter 39
opportunity, entering and running 38
opportunity, saving 39

plan design
adding plan design 143
customizable products, 

reconfiguring 146
policy premiums. See billing accounts
policy record, adding 139
portfolio information

See also financial accounts
household, perspectives available (list 

of) 96
printing call reports 110
privacy flags, setting for call reports 109
product attributes

changing information 143
description 142

product class rate bands
description 142
products, associating with 144

product classes
description 142
employee class, associating with 143

products class matrix
description 142
employee class, associating with 143

products, reconfiguring customizable 
products in plan design 146

proposals, generating 146
providers

about 173
adding a provider 178
business scenario 174
facility, associating with a provider 179

payments, adding manually 182
profile information, adding 181
provider address, adding 179
provider claims, adding 183
provider contract, adding 181
provider payments, viewing 182
provider report, viewing 183
sample tasks (diagram) 176
speciality, associating with a 

provider 180

Q
quotes

active policy, converting to 128
individual health policies, providing 

quotes 125

R
rate band

adding 124
rate band, adding 137
referral information

contact to, creating 80
received from a contact, entering 79

referrals
activities, creating for template 168
activity plan template, creating 168
attachments, adding 172
business scenario 166
creating a referral 169
referral actions, recording 170
referral decisions, recording 171

relationship hierarchy
contact, about viewing 83
contact, defining relationship between 

contacts 84
contact, viewing (procedure) 83
household relationship hierarchy, about 

viewing 95
household relationship hierarchy, 

creating custom-defined 95
reports
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provider report, viewing 183
reports, table of 195

S
S_ACTIVITY_ATT table, location of call 

report attachments 106
service requests

billing account, adding to 190
company, associating with 62
individual health policies, add a service 

request 129
Show edit layout button, about 22
Siebel Account objects, caution renaming to 

Companies 41

Siebel eHealthcare integration messages, 
table of 192

summary information, viewing a household 
summary 94

summary view
controls, about 21
edit layout buttons, about 22

U
underwriting

group policies, adding underwriting 
information 147

historical underwriting information for 
group policies, viewing 147
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